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Communications regulation information

FCC statement
This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. See instructions if interference to
radio or television reception is suspected. 

Radio and television interference
The equipment described in this manual generates, uses, and can radiate radio-frequency
energy. If it is not installed and used properly—that is, in strict accordance with Apple’s
instructions—it may cause interference with radio and television reception. 

This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. These specifications are designed
to provide reasonable protection against such interference in a residential installation. However,
there is no guarantee that interference will not occur in a particular installation. 

You can determine whether your computer system is causing interference by turning it off. If
the interference stops, it was probably caused by the computer or one of the peripheral devices. 

If your computer system does cause interference to radio or television reception, try to correct
the interference by using one or more of the following measures: 
m Turn the television or radio antenna until the interference stops. 
m Move the computer to one side or the other of the television or radio. 
m Move the computer farther away from the television or radio. 
m Plug the computer into an outlet that is on a different circuit from the television or radio.

(That is, make certain the computer and the television or radio are on circuits controlled by
different circuit breakers or fuses.) 

If necessary, consult an Apple-authorized service provider or Apple. See the service and support
information that came with your Apple product. Or, consult an experienced radio/television
technician for additional suggestions.

IMPORTANT  Changes or modifications to this product not authorized by Apple Computer, Inc.,
could void the FCC Certification and negate your authority to operate the product.

This product was tested for FCC compliance under conditions that included the use of Apple
peripheral devices and Apple shielded cables and connectors between system components. It is
important that you use Apple peripheral devices and shielded cables and connectors between
system components to reduce the possibility of causing interference to radios, television sets,
and other electronic devices. You can obtain Apple peripheral devices and the proper shielded
cables and connectors through an Apple-authorized dealer. For non-Apple peripheral devices,
contact the manufacturer or dealer for assistance. 
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DOC statement
DOC Class B Compliance  This digital apparatus does not exceed the Class B limits for radio
noise emissions from digital apparatus as set out in the interference-causing equipment standard
entitled “Digital Apparatus,” ICES-003 of the Department of Communications.  

Observation des normes—Classe B  Cet appareil numérique respecte les limites de bruits
radioélectriques applicables aux appareils numériques de Classe B prescrites dans la norme 
sur le matériel brouilleur : “Appareils Numériques”, NMB-003 édictée par le ministre des
Communications.  

Laser information
WARNING Making adjustments or performing procedures other than those specified in your
equipment’s manual may result in hazardous radiation exposure.

WARNING Do not attempt to disassemble the cabinet containing the laser. The laser beam used in
this product is harmful to the eyes. The use of optical instruments, such as magnifying lenses,
with this product increases the potential hazard to your eyes. For your safety, have this
equipment serviced only by an Apple-authorized service provider. 

Your printer is a Class 1 laser product. The Class 1 label, located in a user-accessible area,
indicates that the printer meets minimum safety requirements. A service warning label is 
located in a service-accessible area. The labels on your product may differ slightly from the
ones shown here.
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The Color LaserWriter 12/660 PS printer is an enhanced version of the Color
LaserWriter 12/600 PS printer. Enhancements include

m additional 4 MB of memory (16 MB total in the printer)

m improved software and firmware to speed up printing

m new printer drivers

Use this update in addition to the Color LaserWriter 12/600 PS User’s Manual.
This update describes the features unique to the Color LaserWriter 12/660 PS
printer. For detailed instructions on setup, transportation, installing options,
and other topics not discussed here, see the Color LaserWriter 12/600 PS
User’s Manual.
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This update at a glance

Chapter/Appendix Contents

Chapter 1 Contains additional information. See also
“Setting up the Color LaserWriter 12/660 PS” Chapter 1, “Setting Up the Color

LaserWriter 12/600 PS” in the Color
LaserWriter 12/600 PS User’s Manual.

Chapter 2 Replaces Chapter 2, “Setting Up the Printer
“Setting Up the Printer for Mac OS Users” for Macintosh Users,” in your printer manual.

Chapter 3 Contains additional information. See also
“Setting Up the Printer for Windows, DOS, Chapter 3, “Setting up the Printer for DOS,
and NetWare Users” Windows, and NetWare Users,” in your

printer manual.

Chapter 4 Replaces Chapter 4, “Setting Up the Printer
“Setting Up the Printer for UNIX Users” for UNIX Users,” in your printer manual.

Chapter 5 Replaces Chapter 6, “Macintosh Users,” in your
“Mac OS Users” printer manual.

Chapter 6 Replaces Chapter 7, “Windows and DOS Users,”
“Windows 3.1 and DOS Users” in your printer manual.

Chapter 7 Replaces Appendix I, “Setting Up and Using
“Windows 95 Users” the Printer With Windows 95,” in your 

printer manual.

Appendix A Contains additional information. See also 
“Moving the Printer” Appendix E, “Packing and Moving the Printer,”

in your printer manual.

Appendix B Contains additional information. See also
“Troubleshooting” Chapter 12, “Fixing Image Problems,” and

Chapter 13, “Troubleshooting,” in your
printer manual.
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The Color LaserWriter 12/660 PS printer uses the same setup procedures as
for the Color LaserWriter 12/600 printer with a few exceptions. This chapter
describes those exceptions. To set up the printer, read this chapter first, then
read Chapter 1 of the Color LaserWriter 12/600 PS User’s Manual.

Choosing a place for the printer

When setting up the printer, be sure to follow these guidelines or your printer
may not operate properly:

m Choose a flat, stable area with adequate room to give you access to all
sides of the printer. The printer weighs approximately 110 pounds
(approximately 50 kilograms). Make sure you place it on a desk or table
that’s strong enough to hold the weight.

m Don’t lift the printer by yourself. Have at least one other person assist you.

m The area should be well ventilated and away from direct sunlight or
sources of heat, cold, or humidity. Abrupt changes in temperature and
extremely high or low humidity can adversely affect print quality.

m Unpack the printer in the location where the printer will be set up. Since
the printer contains a fuser oil reservoir, it is important not to install the
fuser oil bottle until the printer is located where it will be used.

1
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Leveling the printer

Follow the instructions on unpacking the printer in Chapter 1 of the Color
LaserWriter 12/600 PS User’s Manual. After removing the packing tape from
the outside of the printer (step 4), you must level the printer before
proceeding any further.

1 Remove the level and round black rubber shims from their package.

2 Snap the level into its base.

You may have to apply some pressure.

3 Open the printer’s top cover.

WARNING  The desk or table surface must be level. The back of the
printer must be level with the front (or slightly higher—up to 1/2 inches 
[15 mm]) to keep oil inside the printer flowing properly. A level and
round black rubber shims are included with the printer to help you set
up the printer properly.
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4 Place the level on top of the fuser to level the printer first from front-to-back, then from
side-to-side.
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5 Place the shims under the printer’s feet (as needed) to level the printer.

You might want to have one person tilt the printer up and another person
place the shims underneath.
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Removing the oil absorption sheets

After leveling the printer, remove the shipping spacers and oil absorption
sheets from inside the printer.

1 Open the fuser access door and remove the two orange spacers and the oil absorption
sheet from inside.
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2 Open the fixing assembly and remove the oil absorption sheet from inside.
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Additional information

Be sure to do the following when setting up the printer:

m Remove the shipping screw. The shipping screw is encased in an orange
plastic sheath behind the front door. Put the shipping screw in a safe place
in case you ever need to ship the printer to a new location.

m Keep the photoconductor level as you insert it into the printer. Inserting it
at an angle may damage the photoconductor. (Note: Each photoconductor
will yield 5,000 to 25,000 pages, depending on use of color per page.)

m Remove the orange tab and the sealing tape from each of the four toner
cartridges before inserting them into the printer.

WARNING  You must remove the orange tab and the sealing tape.
Otherwise, you might damage the printer.

WARNING  You must remove the shipping screw. Otherwise, you might
damage the printer.
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This chapter explains how to prepare the printer for use on an AppleTalk
network, and prepare Macintosh Operating System (Mac OS)–based
computers to print on the printer. Read this chapter first, then read Chapter 2
of the Color LaserWriter 12/600 PS User’s Manual for instructions on
configuring the printer with the Apple Printer Utility.

Note:  For instructions on setting up the printer for access by Mac OS client
computers on a NetWare network, see Appendix B of the Color LaserWriter
12/600 PS User’s Manual.
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Before you begin

This chapter presents instructions for installing the Mac OS printer software
and configuring the printer with it. Before you begin, make sure you have

m set up the printer as described in Chapter 1 of this update and Chapter 1 of
the Color LaserWriter 12/600 PS User’s Manual

m connected the printer to your network

m made backup copies of the printer disks (if your printer software was
shipped on a CD-ROM disc, you can skip this step)

Be sure to complete these tasks before continuing with the procedures in 
this chapter.

System requirements

To use the printer software, your Mac OS–based computer must have system
software version 7.1 or later and at least 4 megabytes (MB) of memory (8 MB
recommended). If your system software is an earlier version, you need to
obtain a system software upgrade from your computer or software dealer.

Installing all the printer software and fonts requires approximately 9 MB of
free space on your hard disk.

Initial AppleTalk setup

The printer comes with software and fonts for use with Mac OS–based
computers. Before Mac OS users can print, the printer administrator must
connect the printer to the network, install the printer software and fonts, and
configure the printer.
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Step 1:  Installing the printer software

IMPORTANT  Do not “drag install” the printer software. If you do, the files
won’t be properly decompressed and won’t work.

Installing from the CD-ROM disc

1 Quit any programs you are running.

2 Turn off any automatic virus-detection programs you have on your computer.

If you don’t, problems may occur during the installation. After installation is
complete, you can turn the virus-detection programs back on. (For
instructions on turning off each virus-detection program, see the manual that
came with the program, or telephone the manufacturer of the program.)

3 Insert the CD-ROM disc into the CD-ROM drive.

The disc’s icon appears on the desktop.

Note:  Some systems require you to place the disc into a caddy before
inserting it into the CD-ROM drive.

4 Double-click the disc icon to open the disk, if necessary.

5 Double-click the MAC_OS folder, if necessary.

6 Double-click the SOFTWARE folder, if necessary.

7 Double-click the INSTALL folder, if necessary.

8 Read the Before You Install file to check for late-breaking news.

9 Double-click the Installer icon to start the Installer program.

After a moment, a Welcome dialog box appears.

10 Click Continue.

After a moment, the Install dialog box appears. At the top of the dialog box is
a pop-up menu set to allow you to perform an Easy Install.

Easy Install installs all the software you need. It installs the LaserWriter 8
software, the Desktop PrintMonitor, and the Apple Printer Utility.
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Custom Install lets you specify what portions of the software you would like
to install.

IMPORTANT  The Installer checks to make sure you have what you need to use
the printer software. If you’re missing anything, a message tells you what you
need. You won’t be able to install the software until you correct the problem.
If a dialog box says you don’t have the correct system software, you can
purchase a new version from an Apple-authorized dealer.

11 Click the Install button.

The Installer takes a few moments to calculate what needs to be done and
then begins to copy files. 

12 Follow the instructions on the screen until the installation is complete.

After the installation, the Installer tells you to restart your computer.

13 Click the Restart button.

The software is now installed on the hard disk. If you turned off any
automatic virus-detection programs on your computer, turn them back 
on now.

After you restart, you may notice a new icon on your desktop, one that
represents a desktop printer. 

You will also see the Apple LaserWriter Software folder on your hard disk.
This folder contains the Apple Printer Utility and Read Me files.

Creating installation disks from the CD-ROM disc

You can create installation floppy disks from the CD-ROM disc if you don’t
want to give the disc to your users, or if some of your user systems don’t have
a CD-ROM drive. You’ll need seven blank floppy disks. To create installation
disks, follow these steps:

1 Insert the CD-ROM disc into the CD-ROM drive.

The disc’s icon appears on the desktop.

Note:  Some systems require you to place the disc into a caddy before
inserting it into the CD-ROM drive.
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2 Double-click the disc icon to open the disc, if necessary.

3 Double-click the MAC_OS folder, if necessary.

4 Double-click the SOFTWARE folder, if necessary.

5 Copy the DISKS folder to your hard disk.

6 Double-click the DISKS folder.

7 Double-click the Floppy Disk Maker application.

8 Click Full Set.

A dialog box appears that gives you some information, such as the
approximate time it will take to copy the images to floppy disks.

9 Click Start to start the copy process.

10 Follow the instructions on the screen until all disk images have been copied.

Be sure to label the disks.

Installing from the floppy disks

To install the printer software on a Mac OS–based computer, follow these
steps:

1 Quit any programs you are running.

2 Turn off any automatic virus-detection programs you have on your computer.

If you don’t, problems may occur during the installation. After installation is
complete, you can turn the virus-detection programs back on. (For
instructions on turning off each virus-detection program, see the manual that
came with the program, or telephone the manufacturer of the program.)

3 Make sure the disks are locked.

4 Insert LaserWriter Disk 1 for Mac OS into a disk drive.

The disk’s icon appears on the desktop.

Note:  If you are installing from floppy disks made from the CD-ROM disc,
the floppy disk label may be different.

5 Double-click the disk icon to open the disk, if necessary.
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6 Read the Before You Install file to check for late-breaking news.

7 Double-click the Installer icon to start the Installer program.

After a moment, a Welcome dialog box appears.

8 Click Continue.

After a moment, the Install dialog box appears. At the top of the dialog box is
a pop-up menu set to allow you to perform an Easy Install.

Easy Install installs all the software you need. It installs the LaserWriter 8
software, the Desktop PrintMonitor, the Apple Printer Utility, and the Control
Strip module (if the Control Strip is installed).

Custom Install lets you specify what portions of the software you would like
to install.

IMPORTANT  The Installer checks to make sure you have what you need to use
the printer software. If you’re missing anything, a message tells you what you
need. You won’t be able to install the software until you correct the problem.
If a dialog box says you don’t have the correct system software, you can
purchase a new version from an Apple-authorized dealer.

9 Click the Install button.

The Installer takes a few moments to calculate what needs to be done and
then begins to copy files. 

10 Follow the instructions on the screen until the installation is complete.

After the installation, the Installer tells you to restart your computer.

11 Click the Restart button.

The software is now installed on the hard disk. If you turned off any
automatic virus-detection programs on your computer, turn them back 
on now.
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After you restart, you may notice a new icon on your desktop, one that
represents a desktop printer. 

You will also see the Apple LaserWriter Software folder on your hard disk.
This folder contains the Apple Printer Utility and Read Me files.

More information about the Installer program

In the procedure just described, the Installer places all the software you need
onto your hard disk. In rare circumstances, you may want to install only a
subset. For example, you may not want to install the Apple Printer Utility on
your users’ systems because this utility changes the settings in the printer for
all users. In that case, choose Custom Install from the pop-up menu in the
Installer. A list of choices appears. To install something from the list, click to
select it, then click the Install button. (There is also a Custom Remove
feature.)

Step 2:  Choosing the printer

Before you can print with the printer, you must use the Chooser to select the
printer and set up the printer software. You only have to set up the printer
software once, when you first select it. You don’t need to do it again unless
you change printer options, such as increasing memory, or change the way the
printer is connected.

1 Choose the Chooser from the Apple (K) menu.

The Chooser window appears.
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2 In the Chooser dialog box, click items to select them.

3 Close the Chooser.

Step 3:  Naming the printer and setting its zone

Once connected to an AppleTalk network, the printer will appear on the
network with the name Color LaserWriter 12/660 PS. You can change this
name, if you wish. You can use the Apple Printer Utility, installed in the
Apple LaserWriter Software folder, to name the printer.

When a printer is connected to an EtherTalk network with multiple logical
zones, you can also set which zone the printer will be in. You can set the
printer’s zone with the Apple Printer Utility. 

See Chapter 2 of the Color LaserWriter 12/600 PS User’s Manual for more
information on using the Apple Printer Utility.
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Third, click the name of the
printer you want to use. (An
icon beside a printer name
means the printer software
has already been set up.)

Finally, click Create (or
double-click the printer
name—a shortcut).

Second, if the
network has zones,

click the zone where
the printer is located.

First, click this icon.
(If necessary, use the
scroll bar and arrows

to find the icon.)



Step 4:  Making sure everything is working

The best way to make sure everything is set up correctly is to print something.
As a simple print test, open and print one of the Read Me files that is in the
Apple LaserWriter Software folder.

1 Locate the Apple Printer Software Read Me file in the Apple LaserWriter Software folder.

2 Open the Apple Printer Software Read Me file and choose Print from the File menu
(or drag the Read Me file to the desktop printer icon and drop it on the printer).

The Print dialog box appears. If the LaserWriter 12/660 PS printer’s name
does not appear in the dialog box, see “Step 2:  Choosing the Printer.”

3 Click Print.

If the document doesn’t print, check the steps you followed in Chapter 1 of
the Color LaserWriter 12/600 PS User’s Manual for connecting and turning on
the printer. Also check that you have followed all the software installation
steps presented in this chapter. Make sure that you have installed the toner
cartridge and loaded paper into the paper cassette. Check that no packing
material or paper has caused a jam in the printer. 

If the printer still will not print, turn to the troubleshooting chapters of the
Color LaserWriter 12/600 PS User’s Manual. Indicator lights on the front of the
printer blink to signal different errors and printing conditions, such as out of
paper or a paper jam. You can also double-click the desktop printer icon to
check the status messages that appear in the Desktop PrintMonitor. 

Configuring the printer

You may change some of the printer’s default settings using the Apple Printer
Utility. For more information on the Apple Printer Utility, see Chapter 2 of
the Color LaserWriter 12/600 PS User’s Manual. If you want to install any
options, see Chapter 5 of the Color LaserWriter 12/600 PS User’s Manual. Then
you can set up Mac OS–based computers on your network as explained in
“Installing the Software From a Server,” next.
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Installing the software from a server

You can get Mac OS users started with the printer and the new printer
software in whatever way you’re used to. If you’d prefer not to pass around the
software disks, you can place the software on a server, as explained in the next
section. If you prefer, you can of course install the software on each user’s
computer yourself. If you have the users install their own software, make sure
you give them:

m the printer software and instructions for installing it

m the name of the AppleTalk zone on which the printer is located

m the name you gave the printer if you renamed it with the Apple Printer
Utility

Installing onto a server

If you prefer that users install their software from a network server rather
than pass around the original floppy disks or CD-ROM disc, you must copy
the LaserWriter installation software to a server as follows.

Preparing a server using the CD-ROM disc

The CD-ROM disc shipped with the printer contains a network installation
folder. To prepare a server:

1 Insert the CD-ROM disc into the CD-ROM drive.

2 Double-click the disc icon, if necessary.

3 Double-click the MAC_OS folder, if necessary.

4 Double-click the SOFTWARE folder, if necessary.

5 Drag the INSTALL folder from the CD to your server.

Preparing a server using the floppy disks

1 Create a new folder on the server and rename it (for example, Network Install).

2 Insert LaserWriter Disk 1 for Mac OS.
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3 Drag the LaserWriter Disk 1 icon onto the icon of the folder.

IMPORTANT  You must drag the disk icon rather than copy the contents of the
disk directly.

4 Repeat steps 2 and 3 for each printer disk.

5 Open the folder you created in step 1.

The contents of each disk are contained in a folder named for that disk.

6 Open the LaserWriter Disk 1 folder.

7 Select the Installer and Installer Script icons and drag the icons from the LaserWriter
Disk 1 folder to the folder you created in step 1.

The Installer and the Installer Script need to be in the same window as the
folders for the disks you copied.

IMPORTANT  Be sure to tell the users in your group where to find the software
and the name of the folder to look for on the server.
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Installing the printer software from the server

After you’ve copied the software to the server as described earlier in
“Preparing a Server Using the CD-ROM Disc,” users can install the software
on their own computers by following these steps:

1 Turn off any automatic virus-detection programs on your computer before installing the
software.

If you don’t, problems may occur during the installation. After installation is
complete, you can turn the virus-detection programs back on. (For
instructions on turning off each virus-detection program, see the manual that
came with the program, or telephone the manufacturer of the program.)

2 Log on to the server from the computer where you want to install the software.

3 Open the folder that contains the printer software.

4 Double-click the Installer icon.

A dialog box opens to describe the installation.

5 Click the Continue button to close the dialog box.

6 Click the Install button.

The Installer takes a few moments to calculate what needs to be done and
then begins to copy files. 

7 Follow the instructions on the screen until the installation is complete.

After the installation, the Installer tells you to restart your computer.

8 Click the Restart button.

The software is now installed and the printer is ready for use. If you turned
off any automatic virus-detection programs on your computer, turn them back
on now. 
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What to do next

The printer is now set up on your AppleTalk network. The table below can
help you decide which chapter to go to next.

If you want to See in this update

Set up the printer for Windows, DOS, or NetWare users Chapter 3

Set up the printer for UNIX users Chapter 4

Print from a Mac OS–based computer Chapter 5

Print from a Windows 3.1 or DOS computer Chapter 6

Print from a Windows 95 computer Chapter 7
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This chapter describes how to set up the printer for use with IBM PC or
compatible computers running Windows 3.1, Windows 95, Windows NT, or
DOS. It provides detailed procedures for setting up the printer for use on a
Novell NetWare network and instructions for installing the Apple Printer
Utility for Windows. Read this chapter first, then read Chapter 3 of the Color
LaserWriter 12/600 PS User’s Manual for instructions on configuring the
printer with the Apple Printer Utility.

System requirements for Windows 95

To use the printer, your computer system must meet these requirements: 

m IBM PC or compatible, with an 80486 or higher CPU

m hard disk drive

m at least 8 MB of RAM

m Microsoft Windows 95

m CD-ROM drive or 3.5-inch floppy disk drive that reads 1.44 MB disks

m If you’re using the printer on a network, you must set up your network
client software. You may use Client Software for NetWare Network from
Microsoft as your network client software.

Installing all the printer software requires approximately 3.5 MB of free space
on your hard disk.
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System requirements for Windows 3.1 

To use the printer, your computer system must meet these requirements: 

m IBM PC or compatible, with an 80386 or higher CPU

m hard disk drive

m at least 4 megabytes (MB) of random-access memory (RAM)

m Microsoft Windows 3.1 or higher or Windows for Workgroups 3.11 
or higher

m MS-DOS version 3.3 or higher (5.0 or higher recommended) 

m CD-ROM drive or 3.5-inch floppy disk drive that reads 1.44 MB disks

m NetWare requires an 80386 CPU with NetWare version 3.12 or higher

Installing all the printer software requires approximately 3.5 MB of free space
on your hard disk.

Before you begin

Set up the printer as described in Chapter 1 of this update and Chapter 1 of
the Color LaserWriter 12/600 PS User’s Manual, remembering to

m unpack and prepare the printer

m connect the printer to your NetWare network using Ethernet cables or
through a direct parallel connection to a PC (To connect the printer directly
to your IBM PC or compatible computer, you must use a special parallel
interface cable, part number M4235ZM/A, available separately from your
Apple dealer.)

m plug in and turn on the printer (Keep the startup page that automatically
prints out. It provides the default printer name you need for setup.)

24 Chapter  3



Setting up for DOS-based printing

If you will be printing from DOS applications only, you do not need to install
any of the software that came with the printer. However, to print from a DOS
application, you must first install the DOS PostScript driver if one exists for
your DOS application. The DOS PostScript driver is usually supplied with the
DOS application. Follow your application’s instructions for installation and
printing. See also “DOS Notes” in Chapter 6 of this update.

IMPORTANT  This is a PostScript-only printer. Print jobs sent in another
language, such as PCL, will not print. Be sure to send only PostScript files
from the DOS prompt. Otherwise your print job will not print.

Setting up for parallel port printing

Your printer comes with an IEEE 1284-compliant parallel port that requires
an IEEE 1284-compliant cable to connect the printer to your computer.
Purchase the correct cable, part number M4235ZM/A, from an Apple-
authorized dealer.

By default, your printer’s parallel port is ready to receive data, and you should
not need to make any changes to either your computer’s or the printer’s
parallel port setting.

Installing the printer software for Windows 95 and Windows 3.1

As the printer administrator, you must install the printer software on each
computer that will print to the printer. You can do so by using the installation
program that comes on the software disks included with the printer.

Note:  Be sure you have Windows on your computer, before installing the
printer software.

To install the Windows printer software, follow these steps. These instructions
assume that you have a mouse or similar pointing device. If you do not, see
the instructions that came with Windows to find out how to perform these
steps using a keyboard.
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Installing from the CD-ROM disc

Installing onto a Windows 95 computer

1 Start Windows 95.

Before installing the software, make sure the Control Panel and Printers
folder are closed.

2 Insert the CD-ROM disc into the CD-ROM drive.

3 Open the directory on the CD called WIN_OS\WIN95\DISK1

4 Double-click the setup.exe file.

After a few moments, a message appears warning you to close all other
applications before continuing with this installation.

5 Click Next if you have no other open applications.

If you have open applications, click Cancel to stop this installation. Close all
other applications and start the installation process again.

A message appears that lets you view the ReadMe file for late-breaking news.

6 Click Yes to view the ReadMe file.

7 When you have finished reading the ReadMe file, choose Exit from the File menu in the
WordPad application.

A Welcome dialog box is displayed that allows you to select Express
Installation, Custom Installation, or Printer Driver Only.

Express Installation installs all the software you need. It creates the Apple
LaserWriter Software program group and installs within it the PostScript
printer driver, a ReadMe file, the Apple Printer Utility for Windows, and the
Apple LaserWriter Utility for Windows, which you use to name the printer
and perform various printer administrative functions.

Custom Installation lets you specify what portions of the software you would
like to install. 

Printer Driver Only installs only the PostScript printer driver and printer
description files.
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8 Click Express Installation.

A window appears that keeps you informed as file decompression proceeds.

9 Click Next when the Installer prompts you to add a PostScript printer to your system.

A message appears that lets you install the setup program onto your 
hard disk.

10 Select Yes, if desired, and click Next.

The Setup Program Location dialog box appears.

11 Enter a new directory for the setup program or use the default directory and click Next.

A message appears that lets you specify how your printer is connected (local
or network).

12 Select how your printer is connected (local or network) and click Next.

The Install PostScript Printer from PPD dialog box appears.

13 Select the drive that holds your CD from the Drives list box.

14 Select Disk 3 from the Directories list.

15 Select Apple Color LW 12/660 PS from the PostScript Printer Descriptions Available list
and click Next.

16 Select LPT1 if the Color LaserWriter 12/660 PS is connected to your local computer.

17 Click Next.

The Add Printer dialog box appears.

18 Name your computer and select other options as necessary.

19 Click Next.

The printer Properties dialog box appears.

20 Click OK to dismiss the Properties dialog box.

A message appears telling you that the driver software was successfully
installed.
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21 Click Add Another to install another Apple LaserWriter printer. Repeat for each printer
you want to install.

You can install other Apple LaserWriter printers supported by the software.

22 When you’re done, click Exit.

Installation is complete.

23 Choose how to proceed:

For users connected via the parallel cable, the default printer driver settings
should suffice. 

For instructions on using the Apple Printer Utility for Windows, see “Setting
Additional Parameters With the Apple Printer Utility for Windows,” in
Chapter 3 of the Color LaserWriter 12/600 PS User’s Manual.

To configure your printer software with NetWare, see “Initial Novell NetWare
Setup,” later in this chapter.

Installing onto a Windows 3.1 computer

1 Start Windows.

Before installing the software, make sure the Windows Control Panel and
Printers control panel are closed.

2 Insert the CD-ROM disc into the CD-ROM drive.

3 Using the File Manager, open the directory on the CD called WIN_OS\WIN31_NT\DISK1

4 Double-click the setup.exe file.

After a few moments, a message appears warning you to close all other
applications before continuing with this installation.

5 Click Continue if you have no other open applications.

If you have open applications, click Exit to stop this installation. Close all
other applications and start the installation process again.

A message appears that lets you view the ReadMe file for late-breaking news.

6 Click Yes to view the ReadMe file.
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7 When you have finished reading the ReadMe file, choose Exit from the File menu in the
Notepad application.

A Welcome dialog box is displayed that allows you to select Express
Installation, Custom Installation, Print Driver Only, or De-Install.

Express Installation installs all the software you need. It creates the Apple
LaserWriter Software program group and installs within it the ReadMe file,
the Apple Print Monitor for Windows, the Apple Printer Utility for Windows
and the Apple LaserWriter Utility for Windows, which you use to name the
printer and perform various printer administrative functions.

Print Driver Only installs the minimum software needed for printing only.

Custom Installation lets you specify what portions of the software you would
like to install. 

De-Install lets you remove previously installed LaserWriter software.

8 Click Express Install.

A window appears that keeps you informed as file decompression proceeds. 

9 Click Restart Windows.

After Windows restarts, the Adobe PostScript Printers control panel appears.

10 Select the drive that holds your CD from the Drives list box (or select
WIN_OS\WIN31_NT\DISK2)

11 Select Apple Color LW 12/660 PS from the PostScript Printer Descriptions Available list
and click Install.

The PostScript printer driver files are installed on the hard disk. A message
appears telling you that the driver software was successfully installed.

12 Click OK to dismiss the message.

13 Select another Apple LaserWriter printer, if you want, and click Install to install. Repeat
for each printer you want to install.

You can install other Apple LaserWriter printers supported by the software.
`
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14 When you’re done, click Close.

A message appears telling you to use the Printers control panel to connect
and set up the printers you’ve installed. By default, each printer uses LPT1.
The Printers control panel Setup dialog box lets you specify a different port,
for example, LPT2, or a NetWare queue.

Installation is complete.

15 Choose how to proceed:

You can monitor your printer software with the Apple Print Monitor for
Windows; see “Initial Apple Print Monitor for Windows Setup” in Chapter 3
of the Color LaserWriter 12/600 PS User’s Manual.

For instructions on using the Apple Printer Utility for Windows, see “Setting
Additional Parameters With the Apple Printer Utility for Windows,” in
Chapter 3 of the Color LaserWriter 12/600 PS User’s Manual.

To configure your printer software with NetWare, see “Initial Novell NetWare
Setup,” later in this chapter.

Installing onto a server

You can install the software on a server for users who share the server’s copy
of Windows. Follow the steps given in “Installing From the CD-ROM Disc”
and specify the appropriate server volumes and paths. Be sure that the client
workstations have access to the server volumes and paths.

If you install Apple Printer Utility for Windows 3.1 or Windows for
Workgroups 3.11 and a network drive and plan to let other people share the
same directory, make the following changes to the SYSTEM.INI file on all
PC workstations that will be running the utility.

1 Open the SYSTEM.INI file.

2 Locate the [386Enh] section and add the following line:

DEVICE=VECPD.386
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3 Disable the following DEVICE entries by prefixing the line with a semicolon (;). Your
changes should look like this:

;DEVICE=*VPD

;DEVICE=LPT.386

You can also copy the software folders from the CD-ROM disc to a hard disk.
Your users can install the software from the server as described in “Installing
From the CD-ROM Disc” earlier in this chapter.

Creating floppy disks from the CD-ROM disc

From a Windows 95 computer

You can create floppy disk copies of the printer software by using the standard
features of Microsoft Windows 95.

1 Insert the CD-ROM disc into the CD-ROM drive.

2 Double-click the My Computer icon.

3 Double-click the drive that holds your CD.

A window appears that displays the contents of the CD.

4 Insert a blank floppy disk into the a: drive (or b: drive).

5 Double-click the drive that holds your floppy disk.

A window appears that displays the contents of the floppy disk.

6 Open the WIN_OS directory.

7 Drag the WIN95\DISK1 from the CD window to the floppy disk window.

8 Repeat steps 4 through 6 using the WIN95\DISK2 and WIN95\DISK3 directories.

From a Windows 3.1 computer

You can create floppy disk copies of the printer software by using the standard
features of Microsoft Windows 3.1.

1 Open the File Manager.

2 Insert the CD into the CD-ROM drive.
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3 Insert a blank floppy disk into the a: drive (or b: drive).

4 From the File Manager, open the WIN_OS\WIN31_NT\DISK1 directory on the CD.

5 Select Copy from the File menu.

6 Type *.* in the Source field and a: (or b:) in the Destination field.

The files are copied to the floppy disk.

7 Repeat steps 3 through 6 using the WIN31_NT\DISK2 directory.

Installing from the floppy disks

Installing on a Windows 95 computer

1 Find the Windows disks containing the printer software and make sure they’re write-
protected.

Slide up the write-protection tab in one corner of the floppy disk so that you
can see through the hole. 

2 Start Windows 95.

Before installing the software, make sure the Windows Control Panel and
Printer folder are closed.

3 Insert LaserWriter Disk 1 for Windows 95 into a floppy disk drive.

Note:  If you are installing from disks made from the CD, the floppy disk
labels may be different.

4 Click the Start Icon on the Task-Bar and select Run.

5 Type a:\setup or b:\setup (depending on which drive holds your installation
disk) in the command line field and click OK. 

After a few moments, a message appears warning you to close all other
applications before continuing with this installation.

6 Click Next if you have no other open applications.

If you have open applications, click Cancel to stop this installation. Close 
all other applications and start the installation process again.

A message appears that lets you view the ReadMe file for late-breaking news.
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7 Click Yes to view the ReadMe file.

8 When you have finished reading the ReadMe file, choose Exit from the File menu in the
WordPad application.

A Welcome message is displayed that allows you to select Express
Installation, Custom Installation, or Printer Driver Only.

Express Installation installs all the software you need. It creates the Apple
LaserWriter Software program group and installs within it the ReadMe file
the Apple Printer Utility for Windows and the Apple LaserWriter Utility for
Windows, which you use to name the printer and perform various printer
administrative functions.

Custom Installation lets you specify what portions of the software you would
like to install. 

Printer Driver Only installs only the PostScript printer driver and printer
description files.

9 Click Express Installation.

A window appears that keeps you informed as file decompression proceeds.

Insert other printer disks (and click OK) as the program asks for them.

10 Click Next when the Installer prompts you to add a PostScript printer to your system.

A message appears that lets you install the setup program onto your 
hard disk.

11 Select Yes, if desired, and click Next.

The Setup Program Location dialog box appears.

12 Enter a new directory for the printer drivers or use the default directory and click Next.

A message appears that lets you specify how your printer is connected (local
or network).

13 Select how your printer is connected (local or network) and click Next.

The Install PostScript Printer from PPD dialog box appears.
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14 Eject LaserWriter Disk 2 for Windows 95 and insert LaserWriter Disk 3 for Windows 95.

The PostScript PPD files are located on LaserWriter Disk 3 for Windows 95.

15 Choose a: or b: (depending on which drive holds your installation disk) from the Drives
list box.

16 Select Apple Color LW 12/660 PS from the PostScript Printer Drivers Available list and 
click Next.

17 Select LPT1 if the Color LaserWriter 12/660 PS is connected to your local computer.

18 Click Next.

The Add Printer dialog box appears.

19 Name your printer and select other options as necessary.

20 Click Next.

The printer Properties dialog box appears.

21 Click OK to dismiss the Properties dialog box.

A message appears telling you that the driver software was successfully
installed.

22 Click Add Another to install another Apple LaserWriter printer. Repeat for each printer
you want to install.

You can install other Apple LaserWriter printers supported by the software.

23 When you’re done, click Exit.

Installation is complete.

24 Choose how to proceed:

For users connected via the parallel cable, the default printer driver settings
should suffice. 

For instructions on using the Apple Printer Utility for Windows, see “Setting
Additional Parameters With the Apple Printer Utility for Windows,” in
Chapter 3 of the Color LaserWriter 12/600 PS User’s Manual.

To configure your printer software with NetWare, see “Initial Novell NetWare
Setup,” later in this chapter.
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Installing on a Windows 3.1 computer

1 Find the Windows disks containing the printer software and make sure they’re 
write-protected.

Slide up the write-protection tab in one corner of the floppy disk so that you
can see through the hole. 

2 Start Windows.

Before installing the software, make sure the Windows Control Panel and
Printers control panel are closed.

3 Insert LaserWriter Disk 1 for Windows 3.1 into a floppy disk drive.

4 From the Windows Program Manager, choose Run from the File menu.

5 Type a:\setup or b:\setup (depending on which drive holds your installation
disk) in the command line field and click OK. 

After a few moments, a message appears telling you to close all other
applications before continuing with this installation.

6 Click Continue if you have no other open applications.

If you have open applications, click Exit to stop this installation. Close all
other applications and start the installation process again.

A message appears that lets you view the ReadMe file for late-breaking news.

7 Click Yes to view the ReadMe file.

8 When you have finished reading the ReadMe file, choose Exit from the File menu in the
Microsoft Write application.

A dialog box appears that allows you to select Express Installation, Custom
Installation, Printer Driver Only, or De-Install.

Express Installation installs all the software you need. It creates the Apple
LaserWriter Software program group and installs within it the ReadMe file,
the Apple Print Monitor for Windows, the Apple Printer Utility for Windows
and the Apple LaserWriter Utility for Windows which you use to name the
printer and perform various printer administrative functions.
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Custom Installation lets you specify what portions of the software you would
like to install. 

Printer Driver Only installs only the PostScript printer driver and printer
description files.

De-Install lets you remove previously installed LaserWriter software.

9 Click Express Installation.

A window appears that keeps you informed as file decompression proceeds. 

Next, the Installer asks you to press a button to restart Windows.

10 Click Restart Windows.

After Windows restarts, the Adobe PostScript Printers control panel appears.

11 Remove LaserWriter Disk 1 for Windows 3.1 and insert LaserWriter Disk 2 for 
Windows 3.1.

12 Select a: or b: (depending on which drive holds your installation disk) from the Drives
list box.

13 Select the Apple Color LW 12/660 PS and click Install. 

The PostScript printer driver files and other software are installed on the hard
disk. A message appears telling you that the driver software was successfully
installed. 

14 Click OK to dismiss the message.

15 Select another Apple LaserWriter printer, if you want, and click Install to install. Repeat
for each printer you want to install.

You can install other Apple LaserWriter printers supported by the software.

16 When you’re done, click Close.

A message appears telling you to use the Printers control panel to connect
and set up the printers you’ve installed. By default, each printer uses LPT1.
The Printers control panel Setup dialog box lets you specify a different port,
for example, LPT2, or a NetWare queue.
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17 Click OK to dismiss the message.

Installation is complete.

18 Choose how to proceed:

For users connected via the parallel cable, the default printer driver settings
should suffice. 

You can monitor your printer software with the Apple Print Monitor for
Windows; see “Initial Apple Print Monitor for Windows Setup” in Chapter 3
of the Color LaserWriter 12/600 PS User’s Manual.

For instructions on using the Apple Printer Utility for Windows, see “Setting
Additional Parameters With the Apple Printer Utility for Windows” in
Chapter 3 of the Color LaserWriter 12/600 PS User’s Manual.

To configure your printer software with NetWare, see “Initial Novell NetWare
Setup,” later in this chapter.

Installing the printer software for Windows NT

These instructions install the printer on an Intel architecture Windows NT
3.5x Workstation. If you have a Windows NT 3.5x Server or other computer
architecture, see the next section.

Follow the steps below to install the PostScript Printer Description file for
these Apple printers:

m Apple Color LaserWriter 12/660 PS

m Apple Color LaserWriter 12/600 PS

m Apple LaserWriter 12/640 PS

m Apple LaserWriter 16/600 PS

m Apple LaserWriter Select 360

m Apple LaserWriter Pro 600

m Apple LaserWriter Pro 630

1 Start Windows NT 3.5.

2 Insert the CD-ROM disc into the CD-ROM drive.
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3 Using File Manager, open the directory on the CD called WIN_OS\WIN_31_NT\DISK1.

4 Double-click the setup.exe file.

The Welcome screen appears.

5 Select Custom Install and click Windows NT Printer Software. Make sure all other
checkboxes are not checked.

6 Click Install. 

Instructions for installing the Windows NT software appear. 

7 Click Continue.

The Print Manager dialog box appears.

8 Select Create Printer from the Print Manager’s Printer menu.

The Create Printer dialog box appears.

9 Select Other in the Driver Combo box.

10 Type D:\WIN_OS\WIN31_NT\DISK2 when prompted by the Install Driver dialog box.

Replace D: with the letter of your CD-ROM drive.

11 Make sure the correct drive is listed in the Install Driver dialog box and click OK.

A list of printer drivers appears.

12 Select the printer driver that corresponds to your printer and click OK.

13 Follow the instructions on the screen.

14 Click Continue and OK to complete the installation.

Installing the printer on a Windows NT 3.5x Server 
or non-Intel computer architecture

Follow these steps to install the software on a Windows NT 3.5x Server or
non-Intel computer architecture.

1 Copy the PRINTER.INF file located in the D:\WIN_OS\WIN31_NT\DISK2 directory of your
CD-ROM disc to a temporary directory on your hard disk drive.

This example uses C:\TEMP as the temporary directory.
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2 If you are installing onto a Windows NT 3.5x Server:

m Open the PRINTER.INF file with Notepad.

m Search for the [Source Media Description] session.

m Comment out the line for the NT Workstation.

m Uncomment the line for the NT Server.

m Save the file and exit Notepad.

3 Place your Windows NT CD-ROM disc into the CD-ROM drive.

This example uses D: as the CD-ROM drive. Be sure to use the letter that
corresponds to your CD-ROM drive.

4 Double-click the “MS-DOS command prompt” icon in the Main program group.

5 Change to the appropriate architecture by typing:

D:

CD \i386

The i386 directory is for the Intel architecture. You will need to change this
directory according to your system. For example, \PPC is for a computer with
a PowerPC architecture.

6 Expand the PostScript driver components to your temporary directory. The following
command expands the files to the C:\TEMP directory:

expand -r pscr*.* c:\temp

Five files are expanded to your temporary directory: PSCRIPT.CNT,
PSCRIPT.DLL, PSCRIPT.HLP, PSCRIPT.SEP, and PSCRIPTUI.DLL.

7 Double-click the Print Manager icon located in the Main program group.

8 Select Create Printer from the Print Manager’s Printer menu.

The Create Printer dialog box appears.

9 Select Other in the Driver Combo box.

10 Type the location of your PRINTER.INF file when prompted by the Install Driver 
dialog box.

A list of printer drivers appears.
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11 Select the printer driver that corresponds to your printer and click OK.

12 Follow the instructions on the screen.

13 Click Continue and OK to complete the installation.

Initial Novell NetWare setup

NetWare 4.1 introduces the concept of a hierarchical tree database, called
NetWare Directory Services (NDS). NDS is different from the flat file
database called the “Bindery” used in earlier versions of NetWare. The
printer does not support NDS. A NetWare command, SET BINDERY
CONTEXT, allows a single level of the NDS directory tree to be specified as
a virtual Bindery location. Each time you use the NetWare 4.1 file server, set
the file server’s bindery context by typing SET BINDERY CONTEXT at the
console prompt.

The superuser account name also changes with NetWare 4.xx to Admin from
NetWare 3.xx’s name of Supervisor. The Supervisor account still exists in
NetWare 4.xx for backward compatibility, but it can’t actually be seen in the
NDS directory tree. The Admin account gives you full access to the entire
NetWare Directory Services tree. The Supervisor account will only let you
see objects that are in its bindery context location in the tree. When following
the steps below for setting up your printer on NetWare 4.1 as PSERVER,
always use the NetWare Admin account.

Make sure that the NetWare network is set up and operating according to the
instructions in the Novell NetWare documentation.

You should have access to the NetWare Printer Console utility, PCONSOLE,
on the computer from which you will be setting up the printer and have the
administrative privileges necessary to make changes to the network.

IMPORTANT  The printer is a PostScript printer only. If you are using 
NetWare 4.x, use PostScript banner pages only. If you use another type of
banner page, the banner will not print. Do not user banner pages at all with
NetWare 3.x. If you do, the banner and the print job will not print.
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Step 1:  Choosing an operating mode

When setting up your printer for a NetWare network, you have a choice of
three operating modes:

m PSERVER mode, in which the printer emulates NetWare’s PSERVER
software and functions as a dedicated print server

m RPRINTER mode, in which the printer functions as a remote printer

m ATPS (AppleTalk Print Spooler) mode, in which the printer functions as a
remote AppleTalk printer

In PSERVER mode, the factory default, print jobs are stored in a queue on a
specified file server and retrieved by the printer. 

In RPRINTER mode, the printer depends on the NetWare print server
software—either a NetWare Loadable Module (NLM), an RPRINTER.EXE
executable file, or a value-added process (VAP) running on top of the
operating system—to manage printing. Print jobs are stored in a queue on a
specified file server. When the printer is ready to print the job, the NetWare
print server software copies the job to the printer.

In ATPS mode, the printer uses its AppleTalk protocol support to
communicate with the Novell ATPS NetWare Loadable Module (NLM). The
NLM (included in the NetWare for Macintosh package from Novell) extends
full queue and spooling services to Mac OS clients from a server-based
software process.

There are advantages to each type of operating mode. Your choice will
depend on your networking environment and the types of jobs you will be
printing. Regardless of your choice, you can locate the printer anywhere on
the network.
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What to do next

Once you decide how you want to set up the printer, proceed as follows:

m PSERVER  To set up the printer as a print server, read about how to use
PCONSOLE in the next section, then

m if you want a simple setup, read “Step 2, Option A: Setting Up the
Printer as a Print Server (Using PCONSOLE),” later in this chapter.

m if you want to assign a password, read “Step 3:  Assigning a Password for
the Print Server (Optional),” in Chapter 3 of the Color LaserWriter
12/600 PS User’s Manual.

m RPRINTER  To set up the printer as a remote printer, read about how to use
PCONSOLE in the next section, then skip to “Step 2, Option B: Setting
Up the Printer as a Remote Printer (RPRINTER Mode),” later in 
this chapter.

For both PSERVER and RPRINTER, you must also follow the instructions in
“Step 4:  Setting Up the PostScript Printer Driver for NetWare,” in Chapter 3
of the Color LaserWriter 12/600 PS User’s Manual.

For more information about using the Apple Printer Utility read “Setting
Additional Parameters With the Apple Printer Utility for Windows,” in
Chapter 3 of the Color LaserWriter 12/600 PS User’s Manual.

For instructions on setting up the printer for access by Mac OS clients on a
NetWare network, see Appendix B of the Color LaserWriter 12/600 PS
User’s Manual.

Using PCONSOLE

PCONSOLE is a DOS-based utility for configuring printers on a NetWare
network. This chapter provides information on the set of basic PCONSOLE
operations required to set up the LaserWriter 12/660 PS. PCONSOLE is not
provided with the printer. It comes with your NetWare software. Detailed
information about PCONSOLE can be found in your NetWare
documentation.

The descriptions of PCONSOLE in this guide assume the use of keyboard
commands to navigate through the program and perform operations. With the
installation of a DOS mouse driver, you can also use a mouse to make
selections and choose options. 
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The table below lists some basic PCONSOLE key commands.

Command key Description

Esc (Escape) Returns to the previous level

Del (Delete) Deletes a selected item

F7 Cancels changes

Alt-F10 Exits the program

Ins (Insert) Inserts a new item for a list

F1 Displays online help

Arrow keys Cycle through menu selections or entry fields

Step 2, option A:  Setting up the printer as a print server 
(using PCONSOLE)

There are five parts to setting up the LaserWriter 12/660 PS for 
PSERVER mode:

m Create a print server

m Create a printer

m Create a print queue

m Set your printer to PSERVER mode

m Turn the printer off and then back on to have the changes take effect

Create a print server

1 Restart the printer to print a startup page; then obtain the NetWare Printer Name. 

This NetWare Printer Name is the name of the printer on a NetWare network.
It is also the default print server name.

2 Type SET BINDERY CONTEXT at the NetWare file server’s console prompt to
ensure that the context has been set. 

Be sure to write the context down, as it will be needed later.

3 Log in to the NetWare file server from a DOS client using the Admin account.

4 At the DOS prompt, type PCONSOLE and press Enter.
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5 Use the arrow keys to highlight Change Context in the menu, and press Enter.

6 Change the PCONSOLE utility’s context to match the context set on the server (what you
wrote down earlier), by pressing the Ins key, and selecting the correct context.

7 Use the arrow keys to highlight Print Servers in the menu, and press Enter.

8 Press the Ins key, then type the NetWare Printer Name (provided on the printer’s startup
page), and press Enter. 

The print server is created.

Create a printer

1 Select the name of the print server you specified in the previous procedure and 
press Enter.

2 Use the arrow keys to highlight Printers in the Print Server Information menu, and 
press Enter.

This will let you configure the new print server.

3 Press the Ins key to display printers in your current context in the NetWare Directory
Services tree. 

Note:  You may have created a printer earlier. This example assumes that the
printer has not yet been created.

4 Press the Ins key to create a new printer in the NetWare Directory Services tree. 

Make sure that the context listed at the top of the screen still lists the server’s
bindery context that was set earlier. If not, change to the correct context
before creating the printer.

5 At the prompt, type the new printer name and press Enter. 

This name will be used for reference, so use a name that will be meaningful
to the NetWare administrator or to other users who may wish to check on the
printer’s status. This step creates the printer object in the NDS tree.

6 Select the name of the printer you specified and press Enter. 

This adds the printer to the Serviced Printer list of the print server.
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7 From the Serviced Printers menu list, select the name of the printer you specified in the
previous procedure, and press Enter. 

This brings up the Printer Configuration menu.

8 From the Printer Configuration menu, use the arrow keys to highlight Printer type, and
press Enter.

9 From the Printer Type menu, use the arrow keys to highlight Other/Unknown, and 
press Enter. 

This makes your selection active, and brings you back to the Printer
Configuration menu.

10 From the Printer Configuration menu, use the arrow keys to highlight Banner type, and
change the banner type from Text to PostScript. 

Create a print queue

1 From the Printer Configuration menu, use the arrow keys to highlight Print queues
assigned, and press Enter. 

This displays the Print Queue menu list.

2 Press the Ins key to display print queues in your current context in the NetWare
Directory Services tree. 

For this example, you will create a new queue.

3 Press the Ins key to create a new print queue in the NetWare Directory Services tree.

The context listed at the top of the screen should still list the server’s bindery
context that was set earlier. If it doesn’t, change to the correct context before
creating the print queue.

4 At the prompt, type the new queue name and press Enter. 

You are then asked for the NetWare volume to store your NetWare print queue
jobs on. With NetWare 4 the NetWare queue does not have to exist on the
SYS volume—you can place the queue on any volume you choose. Use the
Ins key to select the volume from the directory tree (you may need to navigate
to a different context to select the volume desired).
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5 Select the name of the queue you specified above and press Enter.

This adds the queue to the Print Queue list of the printer.

6 Press the Esc key until you are prompted to save your changes.

Completing the PSERVER configuration with the Apple Printer Utility

1 Start Windows, if it’s not already running.

2 In the Program Manager window, open the Apple LaserWriter Software program group
and double-click the Apple Printer Utility icon.

3 Click Network.

4 Select your printer, then click Open Printer.

5 Select Communication Configuration.

6 Select NetWare Configuration.

7 Enter the PSERVER name. 

Use the same printer name you used in PCONSOLE, if you are not using the
default name.

8 Click the Rescan button.

Rescan sends the new settings to the printer and causes it to renew its
communications with the NetWare file server.

The printer is now ready to function as a print server on the NetWare
network.

Restart the printer

1 Turn the printer off and then back on again.

2 Submit a print job to the printer to ensure it is working.

What to do next:  The next section covers setting up the printer as a remote
printer. If you want to assign a password on the server, see “Step 3: Assigning
a Password for the Print Server (Optional)” in Chapter 3 of the Color
LaserWriter 12/600 PS User’s Manual. Otherwise, see “Step 4: Setting Up the
PostScript Printer Driver for NetWare” also in Chapter 3 of the Color
LaserWriter 12/600 PS User’s Manual.

46 Chapter  3



Step 2, option B:  Setting up the printer as a remote printer
(RPRINTER mode)

There are six parts to setting up the printer for RPRINTER mode:

m Create a print server

m Create a printer from within the print server configuration menu options

m Create a print queue from within the printer configuration menu options

m Set your printer to RPRINTER mode

m Start PSERVER on your NetWare 4.1 file server

m Turn the printer off and then back on to have the changes take effect

Create a print server

1 Turn the printer off, then on, and retrieve the printer’s startup page.

2 Type SET BINDERY CONTEXT at the server’s console prompt to ensure that the context
has been set. Write the context down, as it will be needed later.

3 Log in to a NetWare file server from a DOS client using the Admin account.

4 At the DOS prompt, type PCONSOLE, and press Enter.

5 Use the arrow keys to highlight Change Context in the menu, and press Enter.

6 Change the PCONSOLE utility’s context to match the context set on the server (what you
wrote down earlier) by pressing the Ins key and selecting the correct context.

7 Use the arrow keys to highlight Printer Servers in the menu, and press Enter.

8 Press the Ins key, then type a descriptive name for your printer server. 

This can be any name, but in general you should be able to glance at the
object and know what its purpose is (for example “12_660_Server”).

Create a printer from within the print server configuration menu options

1 Select the name of the print server you specified in “Step 2, Option A: Setting Up the
Printer as a Print Server (Using PCONSOLE)”; then press Enter.

2 Use the arrow keys to highlight Printers in the Print Server Information menu, and 
press Enter. 

This lets you configure the new print server.
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3 Press the Ins key to display printers in your current context in the NetWare Directory
Services tree.

4 Press the Ins key to create a new printer in the NetWare Directory Services tree. 

The context listed at the top of the screen should still list the server’s bindery
context that was set earlier. If this is not the case, change the context to the
correct context before creating the printer.

5 At the prompt, type the new printer name and press Enter.

6 Select the name of the printer you specified in the previous procedure and press Enter. 

This will add the printer to the Serviced Printers list of the print server.

Create a print queue from within the printer configuration menu options

1 From the Serviced Printers menu list, select the name of the printer you specified in the
previous procedure, and press Enter. 

A Printer Configuration menu appears.

2 From the Printer Configuration menu, use the arrow keys to highlight Printer type, and
press Enter.

3 From the Printer Type menu, use the arrow keys to highlight Other/Unknown, and 
press Enter. 

This makes your selection active, and brings you back to the Printer
Configuration menu.

4 From the Printer Configuration menu, use the arrow keys to highlight Banner type, and
change the banner type from Text to PostScript. 

5 From the Printer Configuration menu, use the arrow keys to highlight Print queues
assigned, and press Enter. 

The Print Queue list appears.

6 Press the Ins key to display print queues in your current context in the NetWare
Directory Services tree. 

For this example, you will create a new queue.
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7 Press the Ins key to create a new print queue in the NetWare Directory Services tree.

The context listed at the top of the screen should still list the server’s bindery
context that was set earlier. If it doesn’t, change to the correct context first
before creating the print queue.

8 At the prompt, type the new queue name and press Enter. 

Next you will be asked for the NetWare volume to store your NetWare print
queue jobs on. With NetWare 4.xx, the NetWare queue does not have to exist
on the SYS volume—you can place the queue on any volume you choose. Use
the Ins key to select the volume from the directory tree. You may need to
navigate to a different context to select the volume desired.

9 Select the name of the queue you specified in the previous step and press Enter. 

This adds the queue to the Print Queue list of Printers.

10 Press the Esc key until you are prompted to save your changes.

Set your printer to RPRINTER mode

1 Run the Apple Printer Utility. 

It is located in the Apple LaserWriter Software program group for 
Windows 3.1. On Windows 95, select Programs from Start to find it.

2 Click Network.

3 Click Open Printer.

4 Select Communication Configuration.

5 Select Netware Configuration.

6 Click Remote Printer if it is not already selected, and enter the server name. 

This is the same name you used in PCONSOLE. Enter also the Printer
Number. Again, this is the same number assigned in PCONSOLE.

7 Press Send.

The printer is now ready to function as a remote printer on the NetWare
network.
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Start PSERVER on your 4.1 file server
m Start PSERVER on your 4.1 file server by typing LOAD PSERVER

<Print_Server_Name>.

Turn the printer off and back on for the changes to take effect

1 Turn the printer off and then back on again.

2 Submit a print job to the printer to ensure it is working.

What to do next

You can set additional printer features as explained in the section “Setting
Additional Parameters With the Apple Printer Utility for Windows” in 
Chapter 3 of the Color LaserWriter 12/600 PS User’s Manual.

The printer is now set up on your network. The table below can help you
decide which chapter to go to next.

If you want to See in this update

Set up the printer for UNIX users Chapter 4

Print from a Mac OS–based computer Chapter 5

Print from a Windows 3.1 or DOS computer Chapter 6

Print from a Windows 95 computer Chapter 7
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This chapter explains how to prepare the printer for UNIX users. Users’
computers must be connected to the printer by an Ethernet network using
TCP/IP (Transmission Control Protocol/Internet Protocol). This chapter
replaces Chapter 4 of the Color LaserWriter 12/600 User’s Manual.

Before you begin

Set up the printer as described in Chapter 1 in this update and Chapter 1 of
the Color LaserWriter 12/600 PS User’s Manual, remembering to

m unpack and prepare the printer

m connect the printer to your TCP/IP network using Ethernet cables

m plug in and turn on the printer (Keep the startup page that automatically
prints out. It contains information you’ll need.)
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Initial TCP/IP setup

Before UNIX users can use the printer, the printer administrator must assign
an IP address for the printer, as described in the following sections.

Background information

TCP/IP is a protocol commonly used to connect UNIX systems over Ethernet
networks. Every TCP/IP device must have a unique IP address. Much of the
initial work the printer administrator must do is related to assigning an IP
address (and other associated information) to the printer.

Step 1:  Installing the printer software

You don’t need to install any special UNIX software to administer the printer.
You can control many features of the printer’s TCP/IP interface by using the
Apple Printer Utility program on a Mac OS–based computer or Printer
Utility for Windows on Windows computers (see Chapters 2 and 3 of the
Color LaserWriter 12/600 PS User’s Manual).

Step 2:  Obtaining an IP address for the printer

To be recognized on your TCP/IP network, your printer must be assigned an
IP address. Part of the address identifies your site; the other part uniquely
identifies the device. Most sites have a network administrator who dispenses
IP addresses for all new network devices. Contact your network administrator
for an IP address for the printer.

WARNING  If your TCP/IP network contains devices with duplicate or
incorrect IP addresses, you may experience unpredictable network
behavior, or your network may cease to function. Make sure you obtain
a valid and unique IP address for the printer.
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Step 3:  Assigning an IP address to the printer

When you unpack the printer, it has a unique permanent factory-assigned
Ethernet address, but no IP address. To assign an IP address to the printer,
you can use any one of the following methods, which are described more
fully in the sections that follow:

m ping assignment.  Any printer administrator with superuser privileges can 
use this method, which is sometimes called gleaning. If your network has
neither RARP nor BOOTP services, and you have no access to Windows or
Mac OS–based computers, you must use this method. 

m Macintosh Apple Printer Utility and Apple Printer Utility for Windows.  If your
network includes a Mac OS–based computer or Windows computer, you
can use one of these utility programs to set the printer’s IP address.

m RARP (Remote Address Resolution Protocol).  If your network has a RARP
server, you can use this method.

m BOOTP (Bootstrap Protocol).  If your network has a BOOTP server, you can
use this method.

These methods are described in the next three sections. Choose which section
applies to you, and skip the others.

Printer IP address assignment, option A: Using ping assignment

Any printer administrator with superuser privileges can use the ping

assignment method to assign the printer’s IP address and store it in the
printer’s nonvolatile memory (so it remembers the address even when the
printer is turned off).

Note:  This method works only when the printer has no IP address. If 
you’ve already set the printer’s IP address, you cannot change it by using 
this method.

1 Turn on the printer and save the startup page that prints out.

2 Log in as root to any UNIX workstation on the same subnet as the printer.
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3 Add the following line to the /etc/hosts table on your workstation:

printer_IP_address     printer_IP_name

You obtain the printer IP address from your network administrator. You
choose the printer IP name yourself (if it was not assigned by the network
administrator). It must follow the naming convention of your system, which
generally means it must contain fewer than 32 characters and no special
characters.

Example

80.20.4.78     LaserWriterFloor2 

4 Type the following command to force an entry into your system’s arp table:

arp -s printer_IP_name     printer_Ethernet_address

The printer IP name is the same name you used in step 3. You obtain the
Ethernet address from the startup page that prints automatically when you
turn on the printer. The address appears next to the top icon on the page.

Example

If your startup page showed that your Ethernet address was
08:00:07:2b:48:fb, you would type 

arp -s LaserWriterFloor2     08:00:07:2b:48:fb

5 Type the following ping command to store the printer IP address in the printer’s
memory:

ping printer_IP_name

The printer IP name is the same name you used in steps 3 and 4.

Example

ping LaserWriterFloor2

Normally, the ping command would result in a message telling you the
device received the ping command; however, the printer will not respond
this first time, though it will respond normally in the future.

The address is now stored in the printer’s memory, and you’re ready to test
whether the printer is working.



6 To test the connection, once again type the ping command from a workstation on the
same subnet as the printer:

ping printer_IP_name 

If the ping command responds by telling you that the printer is alive on the
network, the address assignment was successful.

If the ping command does not respond, or tells you the printer was not
found, then the address assignment failed. Try the steps in this procedure
again, making sure you type the printer’s Ethernet address exactly as it
appears on the startup page. If it still doesn’t work, see the troubleshooting
suggestions in Chapter 13 of the Color LaserWriter 12/600 PS User’s Manual.

7 Skip to “Step 4: Configuring Users’ Workstations,” later in this chapter.

Printer IP address assignment, option B: Using Mac OS or Windows utilities 

If you have a Mac OS–based computer connected to the printer, you can use
the Apple Printer Utility to assign the printer’s IP address, as described in
Chapter 2 of the Color LaserWriter 12/600 PS User’s Manual.

If you have a Windows computer connected to the printer, you can use the
Apple Printer Utility for Windows to assign the printer’s IP address, as
described in Chapter 3 of the Color LaserWriter 12/600 PS User’s Manual.

After you have assigned the printer’s IP address, skip to “Step 4: Configuring
Users’ Workstations,” later in this chapter.

Printer IP address assignment, option C:  Using a RARP or BOOTP server 

If your network has a RARP or BOOTP server on the same subnet as the
printer, you can use it to assign the IP address to the printer. Each time the
printer is turned on, it will automatically broadcast a request to RARP and
BOOTP servers, which will search a configuration file that maps the printer’s
built-in Ethernet address to the IP address that you assign.

Your network documentation explains how to add the printer’s information to
the RARP or BOOTP configuration file. 

For troubleshooting information about RARP and BOOTP, see Chapter 13 of
the Color LaserWriter 12/600 PS User’s Manual.
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Step 4:  Configuring Users’ Workstations

You can now set up users’ workstations.

m If you’re using Sun Solaris, see “Configuring Sun Solaris,” next.

m If you’re using Sun OS version 4.1, see “Configuring Sun OS Version 4.1,
Ultrix, A/UX, or Other BSD Systems,” later in this chapter.

m If you’re using HP-UX, see “Configuring HP-UX Version 8.07” or
“Configuring HP-UX Version 9.x,” later in this chapter.

m If you’re using SCO UNIX, see “Configuring SCO UNIX,” later in this
chapter.

m If you’re using IBM AIX, see “Configuring IBM AIX Version 3.x,” later in
this chapter.

m If you’re using a Silicon Graphics workstation, see “Configuring Silicon
Graphics IRIX,” later in this chapter.

Configuring Sun Solaris

1 Log in as root.

2 Assign an IP address and IP name to the printer, as described in “Step 3:  Assigning an
IP Address to the Printer,” earlier in this chapter.

3 Make sure the printer’s IP name and IP address are entered in the /etc/hosts file.

4 Run admintool.

admintool &

5 Select Print Manager.

6 From the Edit menu, choose Add Printers and then Add Access to Remote Printer.

7 Enter the queue name that you want to use in the Printer Name field.
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8 Enter the printer’s IP name in the Print Server field.

9 Select BSD in the Print Server OS field.

10 Click Add.

11 Choose Modify Printer Set File from the Edit menu.

12 Set File Contents to PostScript.

13 Confirm that Accept Print Jobs and Enable Print Queue are set to Yes.

14 Click Apply.

15 Exit admintool and test the installation by printing a file.

Configuring Sun OS version 4.1, Ultrix, A/UX, or other BSD systems

1 Log in as root.

2 Assign an IP address and IP name to the printer, as described in “Step 3:  Assigning an
IP Address to the Printer,” earlier in this chapter. 

3 Make sure the printer’s IP name and address are entered in the /etc/hosts file.

If you’re using Network Information Service (NIS), see the NIS manual for
instructions on setting up an IP name and address.

4 Make sure the lpd daemon is running on the Sun-OS or Ultrix system by typing the
following command at the UNIX prompt:

ps aux | grep lpd

If the lpd daemon is running, you should see output similar to

root 135 0.0 0.0  52  0 ? IW Oct 17 0:01 /usr/lib/lpd

If the lpd daemon is not running, you will not see any output, and you
should start the daemon by logging in as root and typing this command at
the UNIX prompt:

/usr/lib/lpd

You can verify that the daemon is running by using the ps command
described in this step.
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Note:  To start the lpd daemon automatically when the system boots, add
the lpd command to the /etc/rc file. The following is an example
/etc/rc file (syntax varies across operating systems):

if [ -f /usr/lib/lpd ] ; then

rm -f /dev/printer /var/spool/lpd.lock

/usr/lib/lpd;echo -n ' printer'

fi

5 Add the following entry to the /etc/printcap file:

printer_queue_name|[description_of_printer]:\

:lp=:mx#0:rm=printer_IP_name:\

:rp=printer_queue_name:\

:sd=path_to_this_queue’s_spool_directory:\

:lf=path_to_this_queue’s_log_ file:

Fill in the parameters in italics as follows:

m Replace printer_queue_name with the name the user should use to
reference the printer.

m Replace description_of_printer with a comment describing the printer.

m Replace printer_IP_name with the IP name you assigned to the printer in
“Step 3: Assigning an IP Address to the Printer,” earlier in this chapter. 

m Replace path_to_this_queue’s_spool_directory with the pathname of the
unique directory created for this queue. 

m Optionally replace path_to_this_queue’s_log_ file with the unique pathname
of the file where error information from the lpd command will be logged.

Here’s an example of a printcap entry:

Example

GarysLW|[LaserWriter_12_660_PS]:\

:lp=:mx#0:rm=LaserWriterFloor2:\

:rp=GarysLW:\

:sd=/usr/spool/lpd/GarysLW:\

:lf=/usr/spool/lpd/printerlog
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6 Create and set the privileges for the spool directory specified in step 5:

mkdir path_to_this_queue’s_spool_directory

Example

mkdir /usr/spool/lpd/GarysLW

chown daemon /usr/spool/lpd/GarysLW

chgrp daemon /usr/spool/lpd/GarysLW

chmod 775 /usr/spool/lpd/GarysLW

7 To test the connection, type the ping command from a workstation on the same
subnet as the printer:

ping printer_IP_name 

If the ping command responds by telling you that the printer is alive on the
network, the address assignment was successful.

If the ping command does not respond, or tells you the printer was not
found, then the address assignment failed. Try the steps in this procedure
again, making sure you type the printer’s Ethernet address exactly as it
appears on the startup page. If it still doesn’t work, see the troubleshooting
suggestions in Chapter 13 of the Color LaserWriter 12/600 PS User’s Manual.

8 Try printing by using this command:

lpr -Pqueue_name     filename

Note that there’s no space between -P and queue_name.

Example

lpr -PGarysLW file.postscript

If everything is working, the pages will print. If there’s a problem, see the
troubleshooting suggestions in Chapter 13 of the Color LaserWriter 12/600 
PS User’s Manual.
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Configuring HP-UX version 8.07

1 Log in to the system console as root.

The System Administration Manager (SAM) uses a screen-oriented interface
that works best at the console.

2 Assign an IP address and IP name to the printer, as described in “Step 3:  Assigning an
IP Address to the Printer,” earlier in this chapter. 

3 Make sure the printer’s IP name and IP address are entered in the /etc/hosts file.

4 Run the SAM utility by typing sam at the UNIX prompt.

5 Select the following options, in order, from the SAM menu:

Peripheral devices

Printers and Plotters

Actions

Add a Remote Printer (Do not select “Add a Network Printer.”)

A form appears for you to define a remote printer.

6 Enter information into the remote printer form, as follows:

m Printer name  Type the local queue name users will use as the name for 
the printer.

m Remote system name  Type the IP name assigned to the printer as described
in “Step 3:  Assigning an IP Address to the Printer,” earlier in this chapter.

m Remote printer name  Type raw

m Remote cancel model  Used for remote printer job removal; type rcmodel

m Remote status model  Used for remote printer queue status; type rsmodel

m Make this the system default printer? (y or n)  Type y to make this printer the
default printer for all workstations on this segment of the network.

m Printer class  Optional

m Restrict cancel  Optional

m Remote printer on a BSD system? (y or n)  Because this printer is a Berkeley-
style remote printer, type y

7 Choose Perform Task from the SAM menu.
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8 To enable the print queue you just created, choose the following items from the SAM
menu, in order:

Peripheral Devices

Printers and Plotters

Enable a Printer

9 When SAM asks for the printer name, type the IP name assigned to the printer as
described in “Step 3:  Assigning an IP Address to the Printer,” earlier in this chapter.

10 Leave SAM.

11 Start the LP request scheduler by typing

/usr/lib/lpsched

12 To test the connection, once again type the ping command from a workstation on the
same subnet as the printer:

ping printer_IP_name 

If the ping command responds by telling you that the printer is alive on the
network, the address assignment was successful.

If the ping command does not respond, or tells you the printer was not
found, then the address assignment failed. Try the steps in this procedure
again, making sure you type the printer’s Ethernet address exactly as it
appears on the startup page. If it still doesn’t work, see the troubleshooting
suggestions in Chapter 13 of the Color LaserWriter 12/600 PS User’s Manual.

13 Test printing with the following command:

lp -d queue_name     filename

If the test print doesn’t work

If the test document doesn’t print, follow these steps:

1 Check whether the rlp daemon is running. At the UNIX prompt, type

ps -e | grep rlp

If the process is running, you will see one or more lines of text; if it is not
running, you will see no response.
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2 If rlp is running—that is, you saw one or more lines of text in step 1—kill the process
by typing

kill -15 process_number_ from_step_1 

3 Make sure the following entry is in the /etc/inetd.conf file:

printer stream tcp nowait root

/usr/lib/rlpdaemon rlpdaemon -i

This line tells inetd to start the rlp daemon automatically when a print
request is made (if it’s not already running).

4 Make sure the following entry is in the /etc/services file:

printer 515/tcp spooler

5 Start inetd by typing the following command at the UNIX prompt:

/etc/inetd -c

6 Repeat the steps in “Configuring HP-UX Version 8.07.”

Configuring HP-UX version 9.x

You must configure the printer as a remote printer, not as a network printer.

1 Log in to the system console as root.

The System Administration Manager (SAM) uses a screen-oriented interface
that works best at the console.

2 Assign an IP address and IP name to the printer, as described in “Step 3:  Assigning an
IP Address to the Printer,” earlier in this chapter. 

3 Make sure the printer’s IP name and IP address are entered in the /etc/hosts file.

4 Run the SAM utility by typing sam at the UNIX prompt.
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5 Select the following options, in order, from the SAM menu:

Printers and Plotters

Printers/Plotters

Actions

Add a Remote Printer/Plotter (Do not select “Add a Network
Printer.”)

A form appears for you to define a remote printer.

6 Enter information into the remote printer form as follows:

m Printer name  Type the local queue name users will use as the name for 
the printer.

m Remote system name  Type the IP name assigned to the printer as described
in “Step 3:  Assigning an IP Address to the Printer,” earlier in this chapter.

m Remote printer name  Type raw

m Remote cancel model  Used for remote printer job removal; type rcmodel

m Remote status model  Used for remote printer queue status; type rsmodel

m Printer class  Optional

m Make this the system default printer?  Check the box to make this printer the
default printer for all workstations on this segment of the network.

m Allow anyone to cancel requests  Check this box if anyone should be able to
cancel requests.

m Remote printer on a BSD system?  Because this printer is a Berkeley-style
remote printer, check this box.

7 Select the OK button.

A message appears asking you whether you want to add the printer to the
Printer’s subpanel.

8 Click Yes or No.

9 Click OK.

10 Choose Exit from the File menu.

11 Click the Exit SAM button.



12 To test the connection, type the ping command from a workstation on the same
subnet as the printer:

ping printer_IP_name 

If the ping command responds by telling you that the printer is alive on the
network, the address assignment was successful.

If the ping command does not respond, or tells you the printer was not
found, then the address assignment failed. Try the steps in this procedure
again, making sure you type the printer’s Ethernet address exactly as it
appears on the startup page. If it still doesn’t work, see the troubleshooting
suggestions in Chapter 13 of the Color LaserWriter 12/600 PS User’s Manual.

13 Test printing with the following command:

lp -d queue_name     filename

If the test print doesn’t work

If the test document doesn’t print, check the configuration by following 
these steps:

1 Check whether the rlp daemon is running. At the UNIX prompt, type

ps -e | grep rlp

If the process is running, you will see one or more lines of text; it it is not
running, you will see no response.

2 If rlp is running—that is, you saw one or more lines of text in step 1—kill the process
by typing

kill -15 process_number_ from_step_1 

3 Make sure the following entry is in the /etc/inetd.conf file:

printer stream tcp nowait root /usr/lib/rlpdaemon

rlpdaemon -i

This line tells inetd to start the rlp daemon automatically when a print
request is made (if it’s not already running).
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4 Make sure the following entry is in the /etc/services file:

printer 515/tcp spooler

5 Start inetd by typing the following command at the UNIX prompt:

/etc/inetd -c

6 Repeat the steps in “Configuring HP-UX Version 9.x.”

Configuring SCO UNIX

To configure Santa Cruz Operation (SCO) version 1.2 or later of UNIX,
follow these steps:

1 Log in to the SCO machine as root.

2 Assign an IP address and IP name to the printer, as described in “Step 3:  Assigning an
IP Address to the Printer,” earlier in this chapter. 

3 Make sure the printer’s IP name and IP address are entered in the /etc/hosts file.

4 At the UNIX prompt, type

mkdev rlp

5 When the mkdev program asks if you want to install or remove remote line printing,
choose install even if it is already installed.

6 If remote line printing is already installed, the program will ask if you want to continue
installing the system. Answer “no” and skip to step 10.

7 If remote line printing is not already installed, the program will ask if you wish to change
the /etc/printcap file. Answer “no.” 

8 The program then asks if you want to run /etc/rlpconf. Answer “no.” 

9 When asked if you want to start the remote daemon, answer “yes.”

You return to the UNIX prompt.
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10 Add the following entry to the /etc/printcap file.

printer_queue_name|[description_of_printer]:\

:lp=:mx#0:rm=printer_IP_name:\

:rp=printer_queue_name:\

:sd=path_to_this_queue’s_spool_directory:\

:lf=path_to_this_queue’s_log_ file:

Fill in the parameters in italics as follows:

m Replace printer_queue_name with the name the user should use to
reference the printer.

m Replace description_of_printer with a comment describing the printer.

m Replace printer_IP_name with the IP name you assigned to the printer in
“Step 3:  Assigning an IP Address to the Printer,” earlier in this chapter. 

m Replace path_to_this_queue’s_spool_directory with the pathname of the
unique directory created for this queue. 

m Optionally replace path_to_this_queue’s_log_ file with the unique pathname
of the file where error information from the lpd command will be logged.

11 Create the spool directory that you specified in step 10:

mkdir path_to_this_queue’s_spool_directory

12 To test the connection, type the ping command from a workstation on the same
subnet as the printer:

ping printer_IP_name 

If the ping command responds by telling you that the printer is alive on the
network, the address assignment was successful.

If the ping command does not respond, or tells you the printer was not
found, then the address assignment failed. Try the steps in this procedure
again, making sure you type the printer’s Ethernet address exactly as it
appears on the startup page. If it still doesn’t work, see the troubleshooting
suggestions in Chapter 13 of the Color LaserWriter 12/600 PS User’s Manual.

13 Test printing with the following command:

lp -d queue_name     filename
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Configuring IBM AIX version 3.x

1 Log in as root.

2 Assign an IP address and IP name to the printer, as described in “Step 3:  Assigning an
IP Address to the Printer,” earlier in this chapter. 

3 Make sure the printer’s IP name and address are entered in the /etc/hosts file.

4 At the UNIX prompt, type the following to run the SMIT utility:

smit

5 To add a remote queue, choose the following items from the SMIT menu:

Print System Management

Add a Print Queue

Remote

Standard Processing

A form appears for you to define a remote printer.

6 Enter information into the remote printer form, as follows:

m Name of queue to add  Type the local queue name users will use as the name
for the printer.

m Host name of remote server  Type the printer IP name assigned to the printer
as described in “Step 3:  Assigning an IP Address to the Printer,” earlier in
this chapter.

m Name of queue on remote printer  Type raw

m Type of print spooler or remote server  Select BSD.

7 Click Do.

8 Click Done.

9 Choose Exit from the Exit menu.
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10 To test the connection, once again type the ping command from a workstation on the
same subnet as the printer:

ping printer_IP_name 

If the ping command responds by telling you that the printer is alive on the
network, the address assignment was successful.

If the ping command does not respond, or tells you the printer was not
found, then the address assignment failed. Try the steps in this procedure
again, making sure you type the printer’s Ethernet address exactly as it
appears on the startup page. If it still doesn’t work, see the troubleshooting
suggestions in Chapter 13 of the Color LaserWriter 12/600 PS User’s Manual.

11 Try printing by using this command:

lpr -Pqueue_name     filename

Note that there’s no space between -P and queue_name.

Configuring Silicon Graphics IRIX

1 Log in as root.

2 Assign an IP address and IP name to the printer, as described in “Step 3:  Assigning an
IP Address to the Printer,” earlier in this chapter.

3 Make sure the printer’s IP name and IP address are entered in the /etc/hosts file.

4 In the Printer Manager, choose Add from the Printer menu.

5 Enter the queue name that you want to use in the Printer Name field.

6 Choose Network connection type.

7 Enter the printer’s IP name in the Remote Host Name field.

8 Click Apply.

9 Exit the Printer Manager and test the installation by printing a file.
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Configuring the printer

Though the printer itself has no control panel, you can configure it by using
programs on computers connected to the printer:

m On Mac OS–based computers, use the Apple Printer Utility and the
Chooser’s setup function, described in Chapter 2 of the Color LaserWriter
12/600 PS User’s Manual.

m On Windows computers, use the Apple Printer Utility for Windows,
described in Chapter 3 of the Color LaserWriter 12/600 PS User’s Manual.

Each utility has some unique functions and some areas of overlap. For a list of
each utility’s functions, see Appendix A of the Color LaserWriter 12/600 
PS User’s Manual.
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This chapter describes the standard printing and page setup options of the
LaserWriter 8 printer driver and the desktop printer software supplied with
your printer. This chapter replaces Chapter 6 of the Color LaserWriter 12/600
PS User’s Manual.

Selecting and setting up the printer

Before you use your printer for the first time, you must use the Chooser to
select the printer and set up the printer software. 

Once you select the printer in the Chooser, you won’t need to repeat this step
for this printer.

Note:  If you haven’t installed the LaserWriter software, do it now before
continuing with this section. See Chapter 2 in this update for more
information on installing the software.

1 Choose the Chooser from the Apple (K) menu.

The Chooser window appears.

2 Click the LaserWriter 8 icon (in the left half of the Chooser).

If you don’t see the LaserWriter 8 icon, scroll through the window.

3 Click the name of the network zone in which your printer is located, if your printer is
connected to a network with zones.
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The name of your printer appears in the right half of the Chooser (along with
the names of any other available LaserWriter printers). (Your Chooser may
not look exactly like the illustration.)

4 Click the name of your printer.

You’ve now selected the printer for printing. 

If this is the first time you’re using the printer, you must set up the printer
software. When the printer software has been set up, a small printer icon
appears beside the printer name. If your printer software has already been set
up and an icon appears beside the printer name, skip to step 6. To set up the
software, continue with step 5.

5 Set up the printer.

m To let the Chooser identify the type of printer and automatically set up the printer
software, click Create.

By the way:  Double-clicking the printer name is a shortcut for clicking the
name and clicking Create.

m To manually set up the printer software, press the Option key and click Create.
Click the name of the PostScript Printer Description file to be used with
the printer and click Select.

A small printer icon appears beside the printer name.
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6 If you want, you can repeat steps 4 and 5 to create desktop printer icons for other
printers.

7 Close the Chooser.

After you click Create, the new desktop printer icon for the printer appears on
the desktop. 

Desktop printer icons display the icon of the printer selected, unless the
PostScript Printer Description file for the printer selected is not installed in
your Printer Descriptions folder. In this case, the desktop printer icon displays
the icon for LaserWriter 8.

You can drag this icon to any position you want on your desktop or place it
into a folder on your startup drive.

The last desktop printer created becomes the default printer. Your documents
will automatically be printed on the default printer. For more information
about selecting between available printers, see “Switching Between Printers,”
later in this chapter.

If this is your only desktop printer, you can’t get rid of the icon by dragging it
to the Trash. (The icon will reappear if you do.) To get rid of the desktop
printer, you must first select a different desktop printer as the default printer
and then drag the printer icon to the Trash. If you don’t want to use desktop
printer icons, see “Turning off or Removing the Desktop Printing Software,”
later in this chapter, for more information. 

Making changes to the printer setup

If you change options on your printer, you must set up the printer again.

1 Select the desktop printer icon for the printer you want to set up.

2 Choose Change Setup from the Printing menu.



3 Click Auto Setup.

Printer options are displayed in the Setup dialog box. (Your screen may not
look exactly like the illustration.)

4 To change any options (for example, to change 250-sheet cassette and feeder to
“Installed and Preferred”), select the option from the Change pop-up menu and select its
new value from the To pop-up menu.

5 When you’re done, click OK.

Printing

On a Mac OS–based computer, printing functions are controlled through the
Page Setup and Print dialog boxes, which are accessed through the File menu. 

Most Mac OS application programs use a version of the standard Page Setup
and Print dialog boxes, although the exact options presented vary among
programs. (See the manuals that came with your program for details about
specific options.)

The printer administrator can change default settings the printer uses for all
documents with the Apple Printer Utility. For more information about the
Apple Printer Utility, see Chapter 2 of the Color LaserWriter 12/600 PS
User’s Manual.
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Selecting page setup options 

The Page Setup dialog box allows you to specify certain aspects of your
document, such as its page size, format, and orientation, as well as the
settings for several print effects. You can change these settings for every
document you create. It’s recommended that you set your page setup options
when you first create a document. Then, as you view and format the
document it will closely resemble its final printed form.

1 Choose Page Setup from the File menu.

The Page Setup dialog box appears.

2 Select the page setup options you want.

m Select US Letter Small or US Legal Small to prevent pagination
differences when printing to different printers. These paper sizes have the
same physical size as US Letter and US Legal, but have larger margins.
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3 To print using special effects, choose PostScript Options from the Page Setup pop-up
menu. (If you don’t want to choose print options, skip to step 4.)

The PostScript Options dialog box appears.

m Select Flip Horizontal to flip the page image horizontally.

m Select Flip Vertical to flip the page image vertically.

m Select Invert Image to print a black-and-white reversed image.

m Select Substitute Fonts to substitute the fonts Helvetica, Times, and Courier
for the Mac OS screen fonts Geneva, New York, and Monaco, respectively.
The substitution occurs even if TrueType outline fonts are available for
Geneva, New York, and Monaco. Text sizes in the printed document are
scaled to compensate for size differences between the corresponding
families of screen and printer fonts.

m Select Smooth Text to smooth edges of letters when your printer is printing
fonts as bitmapped fonts.

m Select Smooth Graphics to smooth ragged edges of lines in bitmapped
graphics.

m Select Precision Bitmap Alignment to make printed bitmapped graphics
more precisely match the screen image.

m Select Unlimited Downloadable Fonts in a Document to print the
document using as many downloadable fonts as you need. The fonts will
be sent to the printer, used, and then removed from the printer’s memory.
The document will be printed more slowly.
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4 Click OK to close the Page Setup dialog box.

You can make the printer’s current page setup settings the default software
settings by holding down the Option key and clicking OK. (Some programs
may not support this method of setting defaults.)

Printing documents

When you are printing from a Mac OS–based computer, most application
programs display a Print dialog box, in which you specify print options such
as the number of copies you want printed, whether to print all or part of a
document, and which paper tray or cassette will be the paper source. 

Some application programs also add more choices to the Print dialog box. 
For information about such options, refer to the documentation that came
with the program.

1 Choose Print from the File menu.

The Print dialog box appears.

2 Select the options you want.

To print the document
on paper, select
Printer. To save it as a
PostScript or EPS file,
choose File.

To print a transparency
or sheet of paper that
you feed by hand,
select Manual Feed as
the paper source.

To define a single
paper source, click

“All pages from.”
Then choose a paper

source from the 
pop-up menu.

To use your settings
as the default
settings, click 

Save Settings.



IMPORTANT  The names that appear in the paper source menus vary according
to the paper sources of your printer and paper sizes you choose in the Page
Setup dialog box.

m To have the printer automatically select the paper tray that holds the size of
paper chosen for the document, choose Auto Select as the paper source. 

m You can print to other printers by selecting their name from the Printer
pop-up menu. Only printers that have desktop printer icons created with
LaserWriter 8 are listed.

3 When the selections are what you want, choose another setting from the Settings pop-up
menu or click Print.

m To print a cover page, choose Cover Page from the Settings pop-up menu.

m To choose settings for printing color and grayscale images, choose Color
Matching from the Settings pop-up menu.

m To set the number of pages per sheet, choose Layout from the Settings 
pop-up menu.

m To print to a file, choose File from the Destination pop-up menu and
choose “Save as File” from the Settings pop-up menu.

m To set background printing, choose Background Printing from the Settings
pop-up menu.
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m To set the paper type or print quality, choose Printer Specific Options from
the Settings pop-up menu.

m To set program-specific options (such as page order), choose the program’s
name from the Settings pop-up menu.

Printing a cover page automatically

The LaserWriter 8 printing software can automatically print a cover page that
provides information about the printed document, such as the document’s
name and the date and time of printing. You can set the printer to print the
cover page at the beginning or the end of the document. 

1 Choose Print from the File menu.

The Print dialog box appears.

2 Select the options you want.

3 Select Cover Page from the pop-up menu.

The Cover Page dialog box appears.

4 When the selections are as you want, choose another setting from the Settings pop-up
menu, or click Print.
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Printing color and grayscale documents

When you print a document containing colors or shades of gray, you can
choose to maximize either image quality or speed.

1 Choose Print from the File menu.

The Print dialog box appears.

2 Choose Color Matching from the Settings pop-up menu.

The Color Matching dialog box appears.

3 Make the selection you want.

m For the fastest printing, choose Black and White. (The image quality won’t
be as good, especially if the original image is in color or grayscale.)

m If you’re using a customized color-matching method or printer profile,
choose ColorSync Color Matching. When printing with ColorSync Color
Matching, the computer does the work, matching the RGB colors on your
monitor and the printer’s profile and sending the correct CMYK
information to the printer.

Be sure to set the ColorSync system profile to match your monitor. For the
best color match when printing, select the “page-white” or “D50” system
profile for your type of monitor if one is available. (See Appendix D of the
Color LaserWriter 12/600 PS User’s Manual.) 
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m If your print job contains JPEG compressed images (such as QuickTime or
QuickTake images) choose PostScript Color Matching. When printing with
PostScript Color Matching, more color matching is done on the printer.

4 When the selections are what you want, choose another setting from the Settings pop-up
menu or click Print.

Printing more than one page per sheet
You can print multiple pages of your document per sheet of paper.

1 Choose Print from the File menu.

The Print dialog box appears.

2 Choose Layout from the Settings pop-up menu.

The Layout dialog box appears.

3 Make the selections you want.

4 When the selections are what you want, choose another setting from the Settings pop-up
menu or click Print.
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Printing to a file

You can save your document as a PostScript file or an EPS file.

1 Choose Print from the File menu.

The Print dialog box appears.

2 Choose File from the Destination pop-up menu.

3 Choose “Save as File” from the Settings pop-up menu.

The “Save as File” dialog box appears.

4 Make the selections you want.

5 When the selections are what you want, choose another setting from the Settings pop-up
menu or click Print.

Background printing and setting the print time

With background printing turned on, you can use your computer for other
work while you’re printing. Once background printing is turned on, it is in
effect whenever you print, until you turn it off. When you click Print in the
Print dialog box, a message appears for a moment to tell you the document is
being prepared. Once the message disappears, you can continue other work.
Your computer may pause occasionally while it processes the document 
for printing.
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When foreground printing is turned on, you must wait until the document has
finished printing before you can use your computer for other work. However,
your document may be sent to the printer faster when foreground printing is
turned on.

Note:  Background printing uses disk space to store your print job. If you have
limited disk space available, you may want to turn foreground printing on.

You can also specify when your document should be printed in relationship to
other documents that are also being printed. 

1 Choose Print from the File menu.

The Print dialog box appears.

2 Choose Background Printing from the Settings pop-up menu.

The Background Printing dialog box appears.

3 Make the selections you want.

4 When the selections are as you want, choose another setting from the Settings pop-up
menu, or click Print.
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Printing transparencies

To print transparencies, use the multipurpose tray. Load the transparencies so
the white strip goes into the printer first. 

1 Choose Print from the File menu.

The Print dialog box appears.

2 Choose Printer Specific Options from the Settings pop-up menu.

The Printer Specific Options dialog box appears.

3 Choose Transparency from the Paper Type pop-up menu.

4 When the selection is as you want, choose another setting from the Settings pop-up
menu, or click Print.

Changing the Print Quality mode

The Print Quality pop-up menu offers these choices:

m Normal for speed and good quality for most purposes

m Best for improved registration (needed only for special printing jobs)

1 Choose Print from the File menu.

The Print dialog box appears.



2 Choose Printer Specific Options from the Settings pop-up menu.

The Printer Specific Options dialog box appears.

3 Choose an option.

4 When the selection is as you want, choose another setting from the Settings pop-up
menu, or click Print.

Reporting errors

You can specify what happens when a PostScript error occurs or when the
paper cassette runs out of paper. For PostScript errors, you can have the
printer provide no reporting, provide a summary of the print error on your
computer screen (when using foreground printing), or print a page reporting
the error. When the printer is out of paper, you can have the printer use
another cassette with the same paper size or display an alert message.

If you select “Switch to another cassette with same paper size,” the printer
will get paper from its input trays in the following order: standard cassette,
multipurpose tray, optional 250-sheet cassette.
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IMPORTANT  If you have the same size paper in your paper cassettes and
multipurpose tray and have tray switching turned on, the printer may draw
paper from any paper source that has the correct size paper (even if you
select a specific paper source from the Print dialog box). If you want to print
from a specific paper source only, do not select “Switch to another cassette
with same paper size.”

1 Choose Print from the File menu.

The Print dialog box appears.

2 Choose Error Handling from the Settings pop-up menu.

The Error Handling dialog box appears.

3 Make the selections you want.

4 When the selections are as you want, choose another setting from the Settings pop-up
menu, or click Print.
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Printing with a desktop printer

You can also print documents without leaving the Finder, using one of the two
methods described here. These methods are particularly efficient when you
have a number of documents from the same application that you want to print
at once.

m Drag the icons of the documents (from one application) to the desktop icon
of the printer you want to use.

or

m Select the icons of the documents you want to print and choose the Print
command from the File menu. The documents will be printed on the 
default printer. (See “Switching Between Printers,” next.)

In either case, the computer will show you the Print dialog box so you can
choose printing options. Make your choices, then click the Print button.

After a few moments, the document starts to print. If background printing is
turned on, you can continue working while the document is printing. You can
also monitor and control the documents that are waiting to print. (See 
“Monitoring Printing,” later in this chapter.)
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Switching between printers

If you have more than one printer available, you can select which you want to
use. The printer you select is called the default printer. All your documents
will be printed on the default printer until you select a new one.

To change the default printer, use one of these four methods, as described in
the next sections.

m Drag the document you want to print to a desktop printer icon, and it will
automatically become the default printer.

m Select the desktop printer icon and use the Printing menu to set the printer
as the default.

m Select a new printer using the Chooser. 

m Select a new printer using the Printer icon in the desktop menu.

Note:  Switching between printers may change how much information you
can fit on a page. It’s best to choose a printer before you spend much time
formatting the document.

Drag the document you want to print to a desktop printer icon

Drag the icon of any document you want to print to the icon of the printer
you want to use. (See “Printing With a Desktop Printer,” earlier in this
chapter.) 

Printing PostScript files as text

To print a PostScript file as text, hold down the Option key and drag the
document to the icon of the printer you want to use.
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Select the printer using its desktop printer icon

If you already have a desktop printer icon for the printer you want to use,
follow these steps to select the printer without immediately printing anything
on it:

1 Click the icon of the desktop printer you want to use.

A Printing menu appears on the menu bar at the top of the screen.

2 Choose the Set Default Printer command from the Printing menu.

Until you choose another printer, the Print command will send your
documents to this printer.

Shortcut:  Select a desktop printer and press x-L to make that printer the
default printer.

Select a new printer using the Chooser

If you don’t have a desktop printer icon for the printer you want to use, you
must select the printer using the Chooser. The Chooser will then create a
desktop printer icon for the printer that you select.

1 Select the Chooser from the Apple (K) menu.

2 Select the printer that you want.

3 Click the Create button to set up the printer.

4 Close the Chooser by clicking the close box in the upper-left corner.

When you click Create, the Chooser creates a desktop printer icon for the
printer you selected.

Select a new printer from the printer icon in the desktop menu

A printer icon is created next to the Help menu when you use Custom Install
to install the Desktop Printer Menu software. Only printers that have desktop
icons associated with them are listed in the Printer menu. Selecting a printer
from this menu makes that printer the default printer.
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Working with desktop printer icons

To create a desktop printer, select the printer using the Chooser. After you
click Create, the icon will appear on your desktop. See “Select a New Printer
Using the Chooser” under “Switching Between Printers,” the previous section
in this chapter.

You may also do the following with desktop printer icons:

m Throw away the icon.  Drag the icon to the Trash. You can’t throw away a
desktop printer icon while the printer is printing a document. (You can
create another desktop printer icon for that printer whenever you like.) 

Note:  You must always have at least one printer icon on your desktop. If 
you throw away the last icon, it will immediately be created again.

m Rename the icon.  Rename the icon as you would any other Finder icon.
Click the name to highlight it, then type the new name. This changes the
name of the icon, not the name of the printer.

m Move the icon.  You may drag the icon anywhere you like. The icon can
remain on the desktop or be placed in a folder.

m Create an alias for the icon.  You may create an alias for the icon as you would
any Finder icon, by selecting the icon and choosing the Make Alias
command from the File menu. The alias may be moved anywhere on 
or off the desktop.
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Determining the status of a printer by looking at its icon

You can tell the status of a printer by looking at its desktop icon:

Monitoring printing

If you are using background printing, you can use the desktop printer features
to monitor and control the documents that are waiting to print. 

1 Double-click the desktop printer icon you’re interested in.
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Plain icon indicates a printer
that is not currently chosen 
for printing.

Default icon indicates the printer
you have currently chosen to
print on.

Printing icon indicates a
document is printing on 
this printer.

Stopped icon indicates you have
stopped the print queue. 

Error icon indicates there is an
error on this printer. Double-click
the icon to see a message.

Disabled icon indicates the
desktop printing extension is turned
off, the LaserWriter extension is no
longer in the Extensions folder, or
this icon is a copy of an active icon.



A window opens listing the documents that are printing or waiting to print:

Watching the status messages can be helpful when troubleshooting printing
problems. When more than one job is waiting to be printed, a list of print
jobs appears in the waiting list, showing the order in which they will be
printed (when sorted by print time).

2 Choose what you’d like to do.

m To cancel a print request, select it by clicking its title or icon and click the
Remove button. You can click anywhere in the “documents currently
printing” area to select the currently printing document. (You can select
more than one item at a time by holding down the Shift key while clicking.)
You can also drag the icon for the print request to the Trash. Note that these
methods delete only the print request (also referred to as a spool file), not
the document itself.

m To put a print request on hold, select it and click the Hold button. The print
request will stay on hold until you select it again and click the Resume
button. You can also put the document that’s currently printing on hold by
dragging it to the list of documents waiting to print (lower part of the
window).

m To indicate that a print request is urgent, select it and click the Set Print Time
button. In the dialog box that opens, click Urgent. This moves the print
request to the top of your list.
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Column titles (click to sort)

Document currently printing

Documents waiting to print

Select a document and click the Set Print
Time button to specify when the document
should be printed.

Select a
document and

click the Hold Job
button to put a

print request
on hold.

Select a document and click the
Remove button to cancel the print
request.

Select a document
that’s on hold and

click the Resume Job
button to resume

printing.



m To indicate that a print request should not print until a future time, select it and
click the Set Print Time button. In the dialog box that opens, click At Time,
then set the time you want.

m To change the order of the items waiting to print, move their place in the list by
dragging their titles up or down in the list.

m To sort the list of documents waiting to print, click the title of the column you
want to sort by. For example, to sort by the name of the document, click
“Document Name.” (You can also sort by choosing the commands in the
View menu.) The column title you sorted by is underlined. Sorting the
items does not change the order in which they will print. To see that order,
sort by Print Time.

m To temporarily stop all documents from printing on this printer, choose Stop Print
Queue from the Printing menu in the Finder menu bar. To resume using the
printer, choose Start Print Queue from the Printing menu. 

Shortcut:  Pressing the Option-Shift keys changes the Hold Job and Resume
Job buttons to Stop Queue and Start Queue. 

Shortcut:  The Printing menu for starting and stopping the print queue is
available without opening the window for the printer, so long as the printer’s
icon is selected on the desktop.

m To move a print request from one printer to another printer of the same type (for
example, from a LaserWriter 12/660 PS to a LaserWriter 12/640 PS), drag
the icon for the print request to the icon of the printer where you want to
move it. You can only move a print request from a LaserWriter 12/660 PS
to another PostScript printer. The printing software won’t let you move a
print request to an incompatible printer. For example, you can’t move a
request from a LaserWriter printer to a StyleWriter printer.

m To get information about the printer, choose Get Printer Info from the Printing
menu. Status, configuration, and font information is displayed.

m To change the printer setup (for example, when you add or remove printer
options, such as the 250-sheet cassette and feeder), choose Change Setup
from the Printing menu. 

m To change the manual feed alerts, choose Show Manual Feed Alert from the
Printing menu. A checkmark by this command means that the manual feed
alert message will appear.
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Turning off or removing the desktop printing software

You can remove an individual desktop printer icon by dragging it into the
trash. If you have only one desktop printer, you can’t get rid of the icon by
dragging it to the Trash. (The icon will reappear if you do.)

Turning off the Desktop PrintMonitor

If you don’t want to use desktop printers, you can turn off the Desktop
PrintMonitor using the Extensions Manager (available on Mac OS versions
7.5 or later). 

To turn off the Desktop PrintMonitor:

1 Open the Extensions Manager control panel in the Control Panels folder.

2 Click to deselect (uncheck) Desktop PrintMonitor, Desktop Printer Menu, Desktop Printer
Spooler, and Desktop Printer Extension in the panel.

3 Click the close box to close the control panel.

4 Restart your computer.

Removing the desktop printing software

The desktop printing software uses both the Desktop PrintMonitor and the
PrintMonitor software. The Desktop PrintMonitor requires 200-400K bytes
more free system memory in addition to the memory required by the
PrintMonitor. If you don’t want to use the desktop printing software, you can
remove it. 

To remove desktop printing software:

1 Restart your computer with the extensions off by holding down the Shift key and
choosing Restart from the Special menu. 

Hold the Shift key down until the message “Extensions off” appears or until
your normal desktop appears.
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2 Drag the following files from the Extensions folder to the Trash:

m Desktop PrintMonitor

m Desktop Printer Menu

m Desktop Printer Spooler

m Desktop Printer Extension

3 If you have the Control Strip installed on your system, drag the Printer Selector file to 
the Trash.

4 Drag your desktop printer icons to the Trash.

5 Restart your computer.

Making changes to the printer setup

If you turn off desktop printing and add or remove printer options, you must
set up the printer again using the Chooser.

1 Choose the Chooser from the Apple (K) menu.

The Chooser window appears.

2 Click the LaserWriter 8 icon (in the left half of the Chooser).

If you don’t see the LaserWriter 8 icon, scroll through the window.

3 Click the name of the network zone in which your printer is located, if your printer is
connected to a network with zones.

4 Click the name of your printer.

5 Click Setup.

The Setup dialog box appears.
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6 Select the option that you want.

m Click Auto Setup to let the Chooser identify the type of printer and
automatically set up the printer software. 

m Click Select PPD to choose a PostScript Printer Description file for the
printer.

m Click Printer Info to view printer information such as its name, available
memory, and so on.

m Click Configure to set up options that you’ve added to the printer.

7 Click OK.
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The printer comes with software for IBM PC or compatible computers using
Windows 3.1 and Windows 95. This chapter describes how to use the
PostScript Printer Driver for Windows 3.1. This chapter also discusses
printing from DOS. This chapter replaces Chapter 7 of the Color LaserWriter
12/600 PS User’s Manual.

If you are using Windows 95, see Chapter 7 of this update.

Note for Windows NT users:  See “Installing the Printer Software for Windows
NT” in Chapter 3 of this update for installation instructions. Refer also to
your Windows NT manual for instructions about printing.
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Printing from Windows applications

After you have connected the printer to your computer and installed and set 
up the printer software, you’re ready to start printing. This section explains the
basic steps required to print a document, though the details can vary from one
program to another. To find out more about printing from your programs, 
read the documentation that came with them. If you have Windows NT, print
using the TCP/IP protocol or using AppleTalk protocol. See your Windows
NT manual for information on configuring. 

To print a document from a Windows program, the program must be open 
and the document window must be active. 

1 Choose Print from the File menu.

In most cases a Print dialog box appears in which you can select options,
including the number of copies and the pages to print. Depending on your
program, the Print dialog box may offer other options.

2 In the dialog box that appears, select the options you want and click Print.

Selecting page setup options

The Windows Page Setup dialog box allows you to specify certain aspects of
your document, such as its page size, input paper tray source, and orientation.
You can change these settings for every document you create. It’s
recommended that you set your page setup options when you first create a
document. Then, as you view and format the document it will closely
resemble its final printed form.

1 Choose Page Setup (sometimes called Print Setup) from the File menu.

The Page Setup dialog box appears.

2 Select the page setup options you want.
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Setting printer driver options

You can change the PostScript Printer Driver default options. For example, 
you can change the preset paper orientation to Portrait or Landscape.

You set printer options in the printer driver Setup dialog box, which you can
open in three ways, as explained in the sections that follow:

m from the Control Panel

m from your application

m from the Print Manager

Note:  When changing options to print a specific document, it’s preferable to
change the options from within the application. Settings you change from
within an application will affect that document only and not all documents
printed afterward. Settings you change in an application’s Print dialog box
override print options you set in the Setup dialog box.

Opening the printer Setup dialog box from the Control Panel

1 From the Program Manager, double-click the Control Panel icon to display the 
Control Panel. 

2 Double-click the Printers icon to display the Printers dialog box. 

3 Select the printer you want to set up from the Installed Printers list.

4 Choose Setup to display the Setup dialog box for the printer. 

You can also use the Printers dialog box to select a default printer, to switch
the Print Manager on and off, and to connect your printer to a different port.
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Opening the printer Setup dialog box from your application

Most applications have a Print Setup command in their File menus. 

1 Choose the Print Setup command from the File menu.

This command usually displays the Print Setup dialog box. 

2 If you are using more than one printer, select the printer you want to set up.

3 Click the Options (or Setup) button to display the Setup dialog box.

Note:  The names of the commands and buttons used to display the printer
Setup dialog box vary from program to program. See your program’s
documentation for the precise command and button names it uses.

Opening the printer Setup dialog box from the Print Manager

1 From the Program Manager, double-click the Print Manager icon to display the 
Print Manager. 

2 Select the printer you want to set up from the list of Printers. 

3 Choose the Setup or Printer Setup command from the Options menu.

4 Select the printer you want to set up and click Setup.

Selecting printer options in the Setup dialog box

You can change the most commonly used printer settings from the Setup
dialog box. (The tabs in the dialog box also give you access to additional
printer settings. For information about these settings, see “Additional Printer
Options,” next.) The previous sections explain how to open the Setup 
dialog box.



The Paper tab dialog box is displayed first.

m Output Format  Selects either PostScript or Encapsulated PostScript. Use
PostScript for normal printing. Use Encapsulated PostScript to create a file
that can be placed in a document of a program that accepts encapsulated
PostScript images.

m Paper Source  Selects which paper cassette or multipurpose tray to use as the
paper source.

m Paper Size Specifies the paper size. Select the size that matches the paper in
the current paper source.

m Orientation Selects the orientation of the printed page. You can select
Portrait (tall), Landscape (wide), or Rotated Landscape (which prints text
and images in landscape orientation, but reverses the top and bottom of the
page, most useful when you’re printing with three-hole punched paper). 

m Scaling Shrinks or enlarges the print image by a percentage you specify.
You can scale the image from 10 percent to 400 percent.

m Copies Specifies the number of copies of each document page to print.

m Watermarks Specifies which watermark to use.

m Layout Specifies the number of pages to print on each sheet of paper.

m Preview Screen Shows changes you make in the driver settings.
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Additional printer options

In addition to the Paper tab, other tabs display settings for

m PostScript

m Fonts

m Features

m Job control 

m Watermark

PostScript

Click the PostScript tab to display the PostScript tab dialog box, which
controls color printing, the communication protocol, and PostScript 
Level 2 features.

m Use PostScript Level 2 features Tells the driver to use PostScript Level 2
features when printing documents. Use the Level 2 features to 
speed printing.
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m Send Data in Binary Tells the driver to send data to the printer in a binary
format. Sending data in binary format may improve the printer’s
performance when printing images or documents containing many
downloadable fonts. The printer can receive data in either ASCII or 
binary format.

m Send Full Color Data  Tells the driver to print colors on a color printer. Usually
it is best to select this option even when printing to a non-color printer.
Colors print in finer shades of gray.

m Match Colors Across Printers Tells the driver to save color-matching
information with the data for use later when the document is saved to a file
for printing on a different PostScript Level 2 printer.

m Job Timeout Sets the maximum number of seconds that the printer will
spend trying to print a document before canceling the print job. A value of
zero means that the job is never canceled.

m Wait Timeout Sets the maximum number of seconds that the printer will
wait for Windows to send data before canceling the print job. A value of
zero means that the job is never canceled.

m Margins Changes the way the printer driver reports the printable area to the
applications you use. The Default option tells the driver to report the
printable area accurately to the applications. The None option tells the
driver to report the dimensions of the paper as the printable area. 

m Protocol Options Tells the printer driver whether to begin and end print jobs
with Ctrl-D. Default means it will begin and end jobs with a Ctrl-D, and
None means it won’t. If the printer is connected to your computer or
network by its parallel port, click Default; if it’s connected by its Ethernet
port, click None.

m PostScript Performance Tells the driver to build PostScript document
descriptions that print as fast as possible when “Optimize for Speed” is
selected. Such document descriptions might not print successfully on
printers with limited memory. Select “Optimize for Portability” to tell the
driver to build PostScript document descriptions that print successfully on
many different printers.
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Fonts

Click the Fonts tab to display the Fonts tab dialog box. Parameters in this
dialog box control the way the driver prints TrueType fonts used in your
documents. The driver can download available TrueType fonts as TrueType
fonts (Type 42), substitute available PostScript fonts for TrueType fonts, or
automatically create PostScript versions of TrueType fonts and download
them to the printer when you print. 

m Send TrueType Fonts to This Printer as Tells the driver what kind of PostScript
fonts to create for TrueType fonts. Select one of these options:

m Type 1 to synthesize outline PostScript fonts.

m Type 3 to synthesize bitmapped PostScript fonts.

m Type 42 to package TrueType fonts for the PostScript printer. 

m “Don’t Send” to use TrueType fonts that are resident in the printer or are
supplied by print-manager software. (No TrueType fonts are resident on
the printer as it is shipped from the factory.)
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m Substitute PostScript Fonts for TrueType Fonts on This Printer When checked,
tells the driver to substitute PostScript fonts available to the printer for
TrueType fonts. The driver uses the TrueType Substitutions table to
determine which PostScript font to use for each TrueType font installed on
your system. Substituting PostScript fonts for TrueType fonts speeds
printing (especially when the PostScript fonts are resident in the printer).

m TrueType Substitutions for All Printers Lists all the TrueType fonts installed on
your system, and for each TrueType font, shows which PostScript font is
substituted for a TrueType font. This table is used only when you select the
“Substitute PostScript Fonts for TrueType Fonts on This Printer” option.

m For This TrueType Font Shows a list of all the TrueType fonts installed on
your system.

m Substitute This Font Lets you select how font substitution is done. Shows a
list of the PostScript fonts that are substituted for the TrueType fonts. Each
list box lists all the PostScript fonts available to the printer. PostScript
fonts available to the printer include all the fonts resident in the printer’s
ROM, as well as all the Type 1 fonts that you have downloaded to the
printer’s RAM. Each list box also contains a Send As Type 1 option, which
converts the TrueType font to a Type 1 font. The Use Defaults button
restores the original PostScript font substitutions.

IMPORTANT  For information about using Font Downloader, see “Downloading
Fonts,” later in this chapter.
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Features

Click the Features tab to display the Features tab dialog box, which lets you
configure the printer software to use optional printing features that you install
on the printer. Use this dialog box to set up any optional features you may
purchase, such as additional memory or the 250-sheet cassette and feeder. 

m Memory Configuration  The amount of RAM installed in the printer.

m Cassette  Indicates whether you have installed the optional 500-sheet feeder.

m Tray Switch Turns tray switching on or off.
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Job Control

Click the Job Control tab to display the Job Control tab dialog box, which
controls such options as when the PostScript header and the PostScript error
handler are sent to your printer. 

m Printer Mode Lets you set up the printer to receive data in ASCII or 
binary format.

m PostScript Header The PostScript header contains instructions that a
PostScript printer needs to print documents created by the driver. If 
your printer is connected directly to your computer only, you can save 
time by choosing the Download button to send the PostScript header only
once—when you switch on your printer. Download Each Job tells the
driver to send the PostScript header with every document. Already
Downloaded tells the driver not to send the PostScript header with
documents. Download tells the driver to send the header when you choose
the Download button.

m Error Handler Tells the driver to send a special PostScript error handler with
every document you print. The error handler prints a page with a
PostScript error message when a document fails to print correctly. You can
use this option as an aid in troubleshooting print job problems.

m Font Control This advanced feature tells the driver not to download fonts
when printing documents. Use this option if you know that the fonts you
use in your documents are always available to the printer.
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Watermark

Click the Watermark tab to display the Watermark tab dialog box, which
contains options for defining, editing, and deleting watermarks.

m Select a Watermark Lists available watermark definitions, which can be
selected and edited or deleted.

m Edit Displays the Edit Watermark dialog box, summarized below.

m Add Displays the Add Watermark dialog box, which has the same features
as the Edit Watermark dialog box, summarized below.

m Delete Deletes the selected watermark definition.

m Display area A bitmap area that displays a portrait image of what the page
will look like when printed.
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Edit Watermark

Choose the Edit button in the Watermark tab dialog box to display the Edit
Watermark dialog box.

m Text Displays the text of the selected watermark for editing.

m Font Lists all TrueType and ATM fonts and the 13 base PostScript fonts
that either reside in the printer or can be downloaded to the printer.

m Size Lets you specify a font size between 7 and 600 points.

m Style Lets you specify a font style: Regular, Bold, Italic, and Bold Italic, 
as available.

m Print in Foreground Tells the printer to print the watermark in the foreground
rather than in the background (the default). Choose this setting if you
cannot see the watermark on the printed page.

m Print Outline Only Tells the printer to print only the outline of the watermark.
Choose this setting if the watermark is covering graphic images in 
the document.

m Angle Lets you specify the angle at which the watermark will display on
the page.

m Color Lets you specify red, green, and blue values for the color in which
the watermark is printed. As an alternative, Choose Color brings up a
Color dialog box that lets you view and select a color for the watermark. 

111Windows 3.1 and DOS Users



m Position/Automatically Center Watermark/Position Relative to Center Tells the
driver how to position the watermark. Automatically Center Watermark
centers the watermark on the page. Position Relative to Center lets you
specify x and y coordinates for the watermark relative to the center.

Downloading fonts

The printer uses downloadable PostScript fonts, which are a type of soft font.
The PostScript printer driver automatically downloads any Type 1 fonts from
your computer’s hard disk to the printer’s memory as needed for each
document that you print. You can also use the driver to manually download
fonts to the printer’s memory when you don’t want to download fonts for each
document. Manually downloading fonts can speed printing.

Note:  The printer has a set of built-in fonts that do not need to be
downloaded. These fonts are listed in Appendix A of the Color LaserWriter
12/600 PS User’s Manual.

Whether it is better to let Windows download fonts automatically or to
manually download fonts yourself depends on the number and frequency
with which fonts are used in a document and the size of your 
printer’s memory.

Downloading a Type 1 font to a PostScript printer usually takes from 15 to 20
seconds. When a program prints a document containing a font that is not
resident in your printer, Windows automatically downloads the font with the
document. However, after the document prints, any fonts that have been
downloaded with the document are cleared from the printer’s memory. This
means that each time you print a document that contains fonts not resident in
the printer, the fonts must be downloaded.

By contrast, when you manually download a Type 1 font with the Font
Downloader, the font remains in printer memory (RAM) until you switch off
or restart the printer or when memory limitations are exceeded. Manually
downloading frequently used fonts therefore reduces printing time because
the fonts do not have to be sent to the printer each time they are used. Keep in
mind, however, that fonts manually downloaded to RAM reduce the overall
amount of memory available for printing and so may affect the printing of
documents that do not contain the downloaded fonts.
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When you manually download a Type 1 font to a hard disk attached to the
printer, the font is available to the printer and no longer has to be
downloaded. This can speed up printing.

In addition to downloading fonts, you can also use the Font Downloader 
to perform various printer management tasks, such as listing and removing
downloaded fonts, manually downloading PostScript language files, 
clearing the printer font cache, and resynchronizing your printer with the
Windows driver.

See your network administrator for more information about performing these
tasks on your network, or choose the Help button in the Font Downloader
dialog box to see instructions for these tasks. 

Downloading fonts manually to RAM or to the hard disk

Fonts need to be downloaded only once. Users who want to use fonts that
have already been downloaded should use the Job Control tab dialog box
(described earlier in this chapter) to turn on Do Not Download Fonts.
Otherwise, the fonts will be downloaded again, wasting time and 
system resources.

1 From the Program Manager, open the Control Panel.

2 Double-click the Printers icon. 

The Printers dialog box appears.

3 If it is not already selected, select the LaserWriter 12/660 PS from the Installed 
Printers list.
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4 Click Setup. 

The Setup dialog box appears.

Note:  You can also open the Setup dialog box from within many Windows
programs. Check your program documentation to see if you can change your
printer setup from within your program.

5 Click Fonts.

6 Click Font Downloader. 

The Font Downloader dialog box appears.

7 Select the destination device from the Destination Memory list box.

To download to RAM, choose “memory,” or to download to a hard disk,
choose the name of the hard disk.

8 Select the fonts you want to download from the Fonts Available list.

Fonts that are already present in the printer’s ROM do not need to be
downloaded. For a list of these fonts, see Appendix A of the Color
LaserWriter 12/600 PS User’s Manual or print a list of font samples by
choosing Print Font Samples in the Apple Printer Utility for Windows.

9 Click Download. 

The Font Downloader informs you of its progress as it downloads fonts.

Note:  While downloading, you can use other programs, but you can’t print.

10 After you are finished downloading fonts, click Exit. 

You are returned to the Setup dialog box.

11 Click OK to close the Setup dialog box.

12 Click Close to close the Printers dialog box.

13 Choose Exit from the Settings menu to close the Control Panel.

You can confirm that the fonts were downloaded by printing a list of font
samples with the Apple Printer Utility for Windows.
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Using a hard disk

You can add an external hard disk to the printer. A hard disk can store many
soft fonts so they don’t need to be downloaded each time you use them, thus
expediting your printer. Chapter 5 of the Color LaserWriter 12/600 PS User’s
Manual explains how to install a hard disk.

Adding a hard disk to the device list

1 From the Program Manager, open the Control Panel.

2 Double-click the Printers icon.

The Printers dialog box appears.

3 If it is not already selected, select the Color LaserWriter 12/660 PS from the Installed
Printers list.

4 Click Setup.

The Setup dialog box appears.

Note:  You can also open the Setup dialog box from within many Windows
programs. Check your program documentation to see if you can change your
printer setup from within your program.

5 Click Fonts.

6 Click Font Downloader.

The Font Downloader dialog box appears.

7 Click Device Installer.

A dialog box opens.

8 Click Add New.

Another dialog box opens.

9 Make sure “Magnetic disk” is selected, then click Add.
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10 Complete the dialog box as follows:

m Fill in the Available Memory box with the number of kilobytes your hard
disk can store.

m If you have Font Metrics files for the fonts, you can check the Read Font
Metrics File checkbox.

m Make sure the Volatile checkbox is not checked.

m Make sure the Writable checkbox is checked.

11 Click Add.

A dialog box opens.

12 Type a name for the hard disk.

13 Click a button to indicate which SCSI number the hard disk has.

The internal hard disk uses SCSI ID number 0, and the printer’s CPU uses 7.

14 Click OK.

You return to the Device Installer dialog box.

15 Click Close.

If the hard disk installed is already initialized in Apple HFS format, you can
now download fonts. If not, go on to initialize the hard disk.

Initializing the hard disk

If you attach a hard disk to the printer to store fonts, you must initialize it (if
it is not already in Apple HFS format) before you can use it. You can do so by
following the steps below.

1 From the Program Manager, open the Control Panel.

2 Double-click the Printers icon to display the Printers dialog box.

3 If it’s not already selected, select the Color LaserWriter 12/660 PS from the Installed
Printers list.

WARNING  Initializing the hard disk erases all the data on it. Initialize the
hard disk only if you’re sure it’s new or if it’s OK to erase it.
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4 Click Setup.

The Setup dialog box appears.

Note:  You can also open the Setup dialog box from within many Windows
programs. Check your program documentation to see if you can change your
printer setup from within your program.

5 Click the Fonts tab.

6 Click Font Downloader.

The Font Downloader dialog box appears.

7 Click Other.

A dialog box opens.

8 Click the Format Device button, then click OK.

9 Select the disk name and click OK.

Initializing the hard disk takes a few minutes. The Ready/In Use light on the
printer blinks until initialization is complete.

Printing to a PostScript file

As an alternative to printing your document on the printer, you can save a
PostScript language description of your document as a disk file. PostScript
language descriptions of documents can be useful for

m creating document archives

m printing documents without using the program that created them (at a
service bureau, for example)

m diagnosing printing problems

You may also want to print an encapsulated PostScript (EPS) file. You can use
EPS files to export single pages from one program to another. EPS files can
include any combination of text, graphics, and images, but they do not
describe complete documents. For example, by saving an EPS file, you can
insert a page of a document created with one program as an illustration in a
document created by another program.
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Note:  PostScript files are normally ASCII text files that can be opened with
any word-processing program. However, if you select the “Send Data in
Binary” option in the PostScript Options dialog box, the PostScript files may
include binary characters that make them unsuitable for use with a word
processor.

You can use either of two methods to create PostScript files. If your program’s
Print dialog box has a “Print to File” checkbox, you can use this checkbox to
create a PostScript file; this is the preferred method. Refer to your program
documentation for information. If your program’s Print dialog box does not
have a “Print to File” checkbox, however, you need to make temporary
changes to your printer setup to create a PostScript file, as described next.

Using the driver to print to a PostScript file

Using the driver to print to a PostScript file is a three-step process. First,
change your printer setup, then use your program to create the file, and finally
reset your printer setup for normal printing.

Step 1:  Changing your printer setup to print to a PostScript file

1 From the Program Manager, open the Control Panel and double-click the Printers icon.

The Printers dialog box appears.

2 If it is not already selected, select the name of the PostScript printer that you are using
from the Installed Printers list. 

3 Select Connect. 

The Connect dialog box appears. 

4 Select FILE from the Ports list box.

You may have to scroll through the list to find this selection.

5 Choose OK to close the Connect dialog box and return to the Printers dialog box.

6 Choose Setup. 

The driver Setup dialog box appears.

7 After changing (or confirming) your printer settings, choose OK to close the dialog box. 
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Note:  Choose settings in the PostScript Options dialog box that will produce
a file that prints correctly on the destination printer. For example, select the
“Use PostScript Level 2 Features” option if you are sure that you will be
printing the file only on Level 2 printers. If you plan to use a printer that does
not support binary communication, disable the “Send Data in Binary” option.
Selecting the “Optimize for Portability” option creates PostScript files that
print successfully from different programs on a wide variety of printers and
imaging devices; it is recommended that you enable this option.

8 Choose Close to close the Printers dialog box. 

9 Choose Exit from the Settings menu to close the Control Panel.

Your computer is now set up to create PostScript files when you choose the
Print command from a Windows program.

Step 2: Printing to a PostScript file

1 Start the program and open the document for which you want to create a PostScript file.

2 If necessary, select the Print Setup command from the File menu, change the settings as
appropriate, and select OK.

3 Choose the Print command from the File menu. 

Your program’s Print dialog box appears. 

4 Choose OK. 

A dialog box appears that asks you to name the file. 

5 Enter a pathname and filename for the file. 

If you don’t specify a pathname, the PostScript file is placed in your program’s
default directory. 

6 Choose OK. 

The PostScript file is created, and you are returned to your program.
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Step 3:  Restoring your printer setup options

After creating PostScript files, you need to restore your original printer setup
options before you can use your printer again.

1 From the Program Manager, open the Control Panel. 

2 Double-click the Printers icon. 

The Printers dialog box appears.

3 If it is not already selected, select the printer model from the Installed Printers list. 

4 Choose Connect. 

The Connect dialog box appears.

5 In the Ports list box, select the port to which your PostScript printer is connected. 

6 Choose OK. 

The Connect dialog box closes, and you are returned to the Printers 
dialog box.

7 If you changed any printer settings to print a PostScript file, choose Setup to display the
Setup dialog box. Undo any changes you made and then choose OK. 

The Printers dialog box appears.

8 Select OK to close the Printers dialog box.

9 Choose Exit from the Settings menu to close the Control Panel.
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DOS notes

If you are using DOS programs, refer to the manual that came with your
program and follow the instructions for using a PostScript printer. Most DOS
programs are PostScript compatible.

Capturing a print queue for DOS printing

From DOS, you can use the NetWare CAPTURE command to map the 
parallel port to a print queue.

m Log in to the NetWare network and enter the CAPTURE command, using the
following syntax:

CAPTURE /q=queue_name local=lptnumber server=server_name

job=new

Unless you specify otherwise, the command assumes that you are mapping 
the LPT1 port to a queue.

Using the Apple Printer Utility for Windows

The Apple Printer Utility for Windows program supplied with the printer
software lets the printer administrator control various aspects of how the
printer works. For information about using the Apple Printer Utility for
Windows, see Chapter 3 of the Color LaserWriter 12/600 PS User’s Manual.
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This chapter provides information on using the printer with computers
running Windows 95. This chapter replaces Appendix I of the Color
LaserWriter 12/600 PS User’s Manual.

If you are using Windows 3.1 or DOS, see Chapter 6 of this update.

Printing 

On a PC, printing functions are controlled through the Page Setup and Print
dialog boxes, which are accessed through the File menu.

Most Windows application programs use a version of the standard Page Setup
and Print dialog boxes, although the exact options presented vary among
programs. (See the manuals that came with your program for details about
specific options.)

The printer administrator can change default settings the printer uses for all
documents with the Apple Printer Utility for Windows. For more information
about the Apple Printer Utility for Windows, see Chapter 3 of the Color
LaserWriter 12/600 PS User’s Manual.
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Selecting page setup options

The Windows Page Setup dialog box allows you to specify certain aspects of
your document, such as its page size, format, and orientation, as well as the
settings for several print effects. You can change these settings for every
document you create. It’s recommended that you set your page setup options
when you first create a document. Then, as you view and format the
document it will closely resemble its final printed form.

1 Choose Page Setup from the File menu.

The Page Setup dialog box appears.

2 Select the page setup options you want.

Printing documents

When you are printing from Windows, most application programs display a
Print dialog box, in which you specify print options such as the number of
copies you want printed, the layout, and which paper tray or cassette will be
the paper source.

Some application programs also add more choices to the Print dialog box. For
information about such options, refer to the documentation that came with 
the program.

1 Choose Print from the File menu.

2 In the dialog box that appears, make the selections you want.

Setting printing properties

You can change the default properties of the PostScript printer driver. For
example, you can change the default paper orientation from Portrait 
to Landscape.

You set printer options in the printer driver Properties dialog box, which you
can open in three ways, as explained in the sections that follow:

m from the Control Panel

m from the Printers folder

m from your application
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Note:  When changing options to print a specific document, it’s preferable to
change the options from within the application. Settings you change from
within an application will affect that document only and not all documents
printed afterwards. Settings you change in an application’s Print dialog box
override print options you set in the Properties dialog box. 

Opening the printer Properties dialog box from the Control Panel

1 Click the Start icon on the Task-Bar, select Settings and click Control Panel.

2 Double-click the Printers icon.

3 Select the printer you want to change and choose Properties from the File menu.

Opening the printer Properties dialog box from the Printers folder

1 Click the Start icon on the Task-Bar, select Settings and click Printers.

2 Select the printer you want to change and choose Properties from the File menu.

Note:  The Printers folder that appears is the same Printers folder that you see
from the Control Panel.

Opening the printer Properties dialog box from your application

1 Choose Page Setup from the File menu.

2 Click Printers.

3 Select the printer you want to change and click Properties.

To change optional settings for a print job, click Properties, and then make the
changes you want. If you save the changes, they usually persist from one file
to the next. However, if you exit the application and reopen it later, any
properties that you changed may be reset to their original default values.

You can also open the Properties dialog box from the Print dialog box.

Note:  You will see fewer options when opening the Properties dialog box
from your application. To see the complete set of print options, open the
Properties dialog box from the Printers folder.

1 Choose Print from the File menu.

2 Click Properties.
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Selecting printer options in the Properties dialog box

You can change the most commonly used printer settings from the Properties
dialog box. (The tabs in the dialog box also give you access to additional
printer settings. For information about these settings, see “Additional Printer
Options,” later in this chapter.) The previous sections explain how to open the
Properties dialog box.

The Paper tab dialog box is displayed first.

m Paper Size Specifies the paper size. Select the size that matches the paper in
the current paper source.

m Layout Specifies the number of pages to print on each sheet of paper.

m Orientation Selects the orientation of the printed page. You can select
Portrait (tall), Landscape (wide), or Rotated Landscape (which prints text
and images in landscape orientation, but reverses the top and bottom of the
page; most useful when you’re printing with three-hole punched paper). 
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m Paper Source  Selects which paper cassette or multipurpose tray to use as the
paper source.

m Copies Specifies the number of copies of each document page to print.

m Unprintable Area  Displays the Unprintable Area dialog box, used to set the
document margins.

m More Options  Displays the More Options dialog box, used to specify duplex
printing settings.

Setting document margins

Choose the Unprintable Area button in the Paper tab dialog box to display
the Unprintable Area dialog box, which lets you set the page margins.

m Units  Lets you define what unit of measurement to use when setting the
document margins. 

m Top/Bottom/Left/Right  Defines the unprintable area between the sides of the
paper and the text or image of your document.
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Additional printer options

In addition to the Paper tab, other tabs display settings for

m Graphics

m Device Options

m PostScript

m Watermarks

m General

m Details

Graphics

Click the Graphics tab to display the Graphics tab dialog box, which controls
resolution and special printing features.

m Resolution  Lets you specify the printer’s resolution.

m Color control  Lets you define how to match colors.
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m Choose image color matching method  Lets you specify how to match device-
dependent colors to international color standards.

m Halftoning  Lets you specify new frequency and angle values to use for
halftone screens or use the printer’s default values.

m Special  Lets you define special printing features. Select “Print as Negative
Image” to print a black-and-white reversed image. Select “Print as Mirror
Image” to flip the page image vertically.

m Scaling  Shrinks or enlarges the print image by a percentage you specify.
You can scale the image from 10 percent to 400 percent.

Device Options

Click the Device Options tab to display the Device Options dialog box, which
lets you configure the printer software to use optional printing features that
you install on the printer. Use this dialog box to set up any optional features
you may purchase, such as additional memory or the 250-sheet cassette and
feeder.

When the printer runs out of paper in one tray, it can automatically switch
and use paper in another paper cassette or the multipurpose tray. By using
automatic tray switching between the 250-sheet paper cassette and the 
100-sheet multipurpose tray, you can print 350 sheets without reloading
paper. 
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m Available Printer Memory  Lets you specify the amount of available 
printer memory.

m Printer features  Lists the printer features and their current state.

m Change settings for  Sets the value for the feature.

The following options appear only when you open the Properties dialog box
from the Printers folder:

m Installable options  Lists the available options and their current state. For
memory configuration, the amount of memory in the printer is displayed.
For all others, the values could be one of: Not Installed, Installed, or
Installed and Preferred.

m Change settings for  Sets the value for the option. For memory configuration,
select the amount of memory that currently resides in the printer. 

PostScript

Click the PostScript tab to display the PostScript tab dialog box, which
controls the output format. 
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m Output format  Tells the driver to build PostScript document descriptions that
print as fast as possible when “Optimize for Speed” is selected. Such
document descriptions might not print successfully on printers with
limited memory. Select “Optimize for Portability” to tell the driver to build
PostScript document descriptions that print successfully on many different
printers. Select “Encapsulated PostScript” to tell the driver to build an
encapsulated PostScript document description, rather than a PostScript
description. Select “Archive format” to suppress many of the printer
settings that might prevent the file from printing. Choose this option only
if the file might be printed on unknown devices.

The following options appear only when you open the Properties dialog box
from the Printer folder:

m Assume header is downloaded and retained  When checked, tells the driver to
send the document to the printer without the PostScript header.

The PostScript header contains instructions that the printer needs to print
correctly. Select this option only if you are an advanced user with
experience working with PostScript headers.

m Send Header Now  Sends the PostScript header to the printer and selects the
“Assume header is downloaded and retained” option.

m Print PostScript error information  When checked, tells the driver to print any
PostScript errors to the printer.

m Job timeout  Sets the maximum number of seconds that the printer will
spend trying to print a document before canceling the print job. A value of
zero means that the job is never canceled.

m Wait timeout  Sets the maximum number of seconds that the printer will wait
for Windows to send data before canceling the print job. A value of zero
means that the job is never canceled.

m Advanced  Displays the Advanced PostScript dialog box, used to set data
communication protocol and format. Only experienced PostScript users
should set options in the Advanced PostScript dialog box.
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Advanced PostScript options

Choose the Advanced button in the PostScript tab dialog box to display the
Advanced PostScript Options dialog box.

m PostScript language level  Lets you specify which level of PostScript language
to use.

m Bitmap compression  Lets you specify whether to compress graphics before
sending your document to the printer. If you’re using PostScript language
level, click No Bitmap Compression.

m ASCII data  Sends all data in Adobe Communication Protocol. ASCII data
format allows the file to print on any printer.

m Binary communications protocol  Sends all data except special control
characters in binary (8-bit) format.

m Tagged binary communications protocol  Sends all data except special
characters in binary (8-bit) format over serial or parallel ports. 

m Pure binary data  Sends all data in pure binary format. This option works
only on AppleTalk or Ethernet networks.

m Send CTRL+D before job  Sends CTRL+D to the printer before a print job to
reset the printer.
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m Send CTRL+D after job  Sends CTRL+D to the printer after a print job to
notify the printer the current job is finished and to reset the printer.

m Display alert for applications incompatible with driver features  When checked,
displays a message if an application might be incompatible with some
driver features.

Watermarks

Click the Watermark tab to display the Watermark tab dialog box, which
contains options for defining, editing, and deleting watermarks.

m Select a Watermark Lists available watermark definitions, which can be
selected and edited or deleted.

m Edit  Displays the Edit Watermark dialog box, summarized next.

m New  Displays the New Watermark dialog box, which has the same features
as the Edit Watermark dialog box, summarized next.

m Delete  Deletes the selected watermark definition.
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m Print watermark  Tells the printer how the watermark should be printed. You
can print on the first page only rather than on all pages (the default). You
can print the watermark in the foreground rather than in the background
(the default). Choose this setting if you cannot see the watermark on the
printed page. You can print only the outline of the watermark. Choose this
setting if the watermark is covering graphic images in the document.

m Display area  A bitmap area that displays a portrait image of what the page
will look like when printed.

Edit watermark

Click the Edit button in the Watermark tab dialog box to display the Edit
Watermark dialog box.

m Text  Displays the text of the selected watermark for editing.

m Font  Lists all TrueType and ATM fonts and the 13 base PostScript fonts
that either reside in the printer or can be downloaded to the printer.

m Size  Lets you specify a font size between 7 and 600 points.

m Style  Lets you specify a font style: Regular, Bold, Italic, and Bold Italic, as
available.

m Angle  Lets you specify the angle at which the watermark will display on
the page.
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m Position/Automatically Center Watermark/Position Relative to Center  Tells the
driver how to position the watermark. Automatically Center Watermark
centers the watermark on the page. Position Relative to Center lets you
specify x and y coordinates for the watermark relative to the center.

m Color  Lets you specify red, green, and blue values for the color in which
the watermark is printed. As an alternative, Choose Color brings up a
Color dialog box that lets you view and select a color for the watermark.

Fonts

Click the Fonts tab to display the Fonts dialog box, which controls font
substitution. The Fonts tab is available only if you open the Properties dialog
box through the Printer folder.

m Send TrueType fonts to printer according to the Font Substitution Table  Tells the
driver to use the Font Substitution Table to determine which PostScript
fonts to substitute for TrueType fonts.

m Edit the Table  Displays the Font Substitution Table, used to substitute
PostScript fonts for TrueType fonts in your document.

m Always use built-in printer fonts instead of TrueType fonts  Tells the driver to
ignore the Font Substitution Table and to use font-matching rules to find
the best PostScript font to substitute for TrueType fonts in your document.

m Always use TrueType fonts  Tells the driver to send TrueType fonts to the
printer when your document is printed.

m Update Soft Fonts  Lets you update the list of installed PostScript fonts so
that the printer driver prints them correctly.

m Send Fonts As  Displays the Send Fonts As dialog box, used to specify how
to send TrueType or PostScript fonts.

Specifying how to send TrueType or PostScript fonts

Click the Send Fonts As button in the Fonts tab to display the Send Fonts As
dialog box.

m Send TrueType fonts as  Lets you specify the format used to send TrueType
fonts that are not substituted with their PostScript equivalent fonts. For
Type 1 (outline) fonts, select Outlines. For Type 3 (bitmap) fonts, select
Bitmaps. Select “Don’t Send” if you don’t want any fonts sent.
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m Threshold  Lets you specify the size of the font at which the PostScript
driver should switch from sending TrueType fonts as Type 1 to sending
them as Type 3 (bitmap) fonts.

m Favor system TrueType fonts  When checked, tells the driver to use the system
TrueType font instead of the printer font when the same font is found on
both the printer and the computer.

m Send PostScript Fonts As  Lets you specify how to send PostScript fonts to
the printer. Select Native Format to send PostScript fonts before your
document. Select Don’t Send to send no PostScript fonts to the printer.

General

Click the General tab to display the General tab dialog box, which lets you
insert comments about the printer and specify whether to use a separator
page between print jobs. The General tab is available only when you open the
printer Properties dialog box from the Printers folder.

m Comment  Displays any general description about the printer. Text in the
Comment option is displayed to users when they select a network printer.

m Separator page  Tells the printer to place a page between print jobs. You can
select what kind of text or graphics goes on a separator page.
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Details

Click the Details tab to display the Details tab dialog box, which controls the
printer port. The Details tab is available only when you open the printer
Properties dialog box from the Printers folder.

m Print to port  Lets you specify the port your printer is attached to or the path
to the network printer you’re using.

m Add Port  Click to add a new port or to specify a new network path.

m Delete Port  Click to delete a port from the “Print to port” list box.

m Print using driver  Lets you specify the type of printer you’re using.

m New Driver  Click to update your printer driver.

m Capture Printer Port  Click to map a port to a network drive.

m End Capture  Click to remove a port from a network drive.
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m Timeout settings/Not selected/Transmission retry  “Not selected” specifies how
long Windows 95 waits for the printer to be online before reporting an
error. “Transmission retry” specifies how long Windows 95 waits for the
printer to be ready before reporting an error.

m Spool Settings  Click to specify how the document is sent from the
application to the printer.

m Port Settings  Click to change your port settings.

Add Port

The Add Port dialog box lets you add a new port or specify a network path.

m Network  When selected, tells the driver you want a network printer. Specify
the path to the network printer in the text box.

m Other  Lets you select another type of port, such as a FAX port.

Spool Settings

The Spool Settings dialog box specifies spool print jobs and data format.

m Spool print jobs so program finishes printing faster  When selected, saves
printing information on your computer’s hard disk until the printer is ready
to print.

m Start printing after last page is spooled  When selected, waits until all printing
information has come from the application before sending it to the printer.

m Start printer after first page is spooled  When selected, starts sending printing
information from your disk to the printer after one page has been received
from the application.

m Print directly to the printer  When selected, waits until your printer is ready
before sending the print job from the application to the printer.

m Spool data format  Lets you specify the format in which to store printing
information on your disk while a print job is waiting to be printed.

m Enable bidirectional support for this printer/Disable bidirectional support for this
printer  Specifies whether the printer should communicate with the
computer bidirectionally.
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Using the Apple Printer Utility for Windows

The Apple Printer Utility for Windows program supplied with the printer
software lets the printer administrator control various aspects of how the
printer works. For information about using the Apple Printer Utility for
Windows, see Chapter 3 of the Color LaserWriter 12/600 PS User’s Manual.

139Windows 95 Users





IIIpart

Appendix A Moving the Printer

Appendix B Troubleshooting

Appendixes





This appendix lists a few of the guidelines you must follow when moving
your printer. Refer to Appendix E of the Color LaserWriter 12/600 PS User’s
Manual for detailed information on packing and moving the printer.

m Remove the printer supplies (toner, photoconductor cartridge, fuser oil
bottle, and the remaining oil in the oil reservoir) before moving the printer.
This prevents oil spillage inside the printer.

m Keep the printer level while moving it. This prevents oil spillage and fuser
sensor failure. 

m Use a sturdy, level cart when transporting the printer. Do not use a chair or
handcart.

m If possible, use the printer’s original packaging material to protect the
printer during transport.

m When unpacking the printer, follow the steps described in Chapter 1 of
this update and in Chapter 1 of the Color LaserWriter 12/600 PS User’s
Manual.
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This appendix provides solutions to problems you may have with the printer.
For more troubleshooting tips, see Chapters 12 and 13 of the Color
LaserWriter 12/600 PS User’s Manual. 

Note:  For easier troubleshooting, it’s a good idea to turn off background
printing.

General printing problems

The printer jams when printing on transparencies.

If your printer jams when trying to print on transparencies, try these steps:

m Use only Apple Color LaserWriter Transparencies (Apple part number
M3876G/A for letter-size transparencies and Apple part number
M3877G/A for A4-size transparencies). The printer is designed to accept
only these transparencies. Using other brands of transparencies could
damage your printer.

m If you are using Apple Color LaserWriter Transparencies, be sure to use the
multipurpose tray to load transparencies. Loading transparencies in either
the standard paper tray or the optional paper tray can cause paper jams.
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m If you are experiencing paper jams while using Apple Color LaserWriter
Transparencies loaded in the multipurpose tray, be sure you’ve placed the
transparencies properly. See the section “Placing Paper and Transparencies
in the Multipurpose Tray” in Chapter 9 of the Color LaserWriter 12/600 PS
User’s Manual.

Horizontal bands appear on the printed page.

When you print solid color images, you can expect some horizontal banding
(fine horizontal lines that are more obvious in solid color areas). To minimize
banding, try these steps:

m Banding typically appears when a new printer is first being used (typically
the first 500 to 1000 pages). Banding decreases through the break-in
period; however, some level of banding may still appear when printing
large areas of solid dark colors.

m Use a lighter background color, rather than dark.

m Replace the toner cartridge containing the associated color.

m Replace the photoconductor cartridge.

Oil spots appear on printed pages.

Oil spots can appear on pages when the oil reservoir inside the printer
overflows. Oil can spill inside the fuser assembly when the printer is not
level, or when the printer was transported improperly. If you see oil spots on
printed pages, try these steps:

m Be sure the printer is on a level surface. See Chapter 1 of this update for
more information on leveling the printer. 

m Avoid powering the printer off and on frequently. Each time the printer
powers up, it cycles fuser oil through the oil reservoir. This can leave
excess oil on the print mechanism.

m If oil spots appear on your transparencies, try printing on a few pages of
paper before continuing to print on your transparencies.
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A light film of fuser oil appears on the exterior of the printer near the multipurpose tray.

Oil can spill out of the fuser assembly and appear on the exterior of the
printer if the printer is not level. You can remove the oil from the printer’s
exterior with paper towels and a window cleaner. Do not use paper towels and
window cleaner on the interior of the printer. See Chapter 1 of this update for
information on leveling the printer.

The Paper Jam and Paper Out lights are flashing, and the yellow toner cartridge and the
photoconductor indicator lights are on.

This symptom indicates either a fuser pump has failed or that oil in the fuser
assembly has spilled or overflowed. Try the following steps:

1 Verify that the printer is level. 

See Chapter 1 of this update for the procedure for leveling the printer.

2 Turn the printer off.

3 Open the access door and remove the fuser oil bottle.

4 Open the fuser access door and pump the fuser lever a minimum of 50 times.

If the above steps do not fix the problem, contact an Apple-authorized service
provider, or in the U.S., call 1-800-SOS-APPL.

A spot or line appears on every printed page.

If the spot appears approximately every 5 1/2 inches, the photoconductor
cartridge is probably damaged. Try replacing the photoconductor cartridge.
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Mac OS–based computer troubleshooting

The desktop printer icon has an X drawn through it.

The X indicates that the desktop printing software is turned off or the
LaserWriter 8 extension is not in the Extensions folder.

m You may have started the computer using a different startup disk or
temporarily turned off all the software extensions. When you restart the
computer as usual, the icons will return to normal.

m You may have removed the desktop printing software that created the
printer icons. If you meant to do so, you can drag the icons to the Trash or
to any folder outside the Extensions folder. If not, you can reinstall the
software as explained in Chapter 2 of this update.

m The driver for the desktop printing software is no longer in the Extensions
folder.

m The desktop printer icon is a duplicate of an active desktop printer.

The desktop printing software needs more memory on the computer.

If desktop printing needs more memory, try closing open windows and
quitting open programs. Each desktop printer that you use also requires
memory, so try reducing the number of desktop printer icons on your desktop
by dragging desktop printers you no longer need to the Trash. You can also
allocate more memory to the Desktop PrintMonitor. To allocate more
memory, open the Extensions folder in your System Folder and select the
Desktop PrintMonitor icon. Choose Get Info from the File menu and enter a
larger amount of memory in the Preferred Size box, then close the Get Info
box. To allocate more memory to a specific desktop printer, select the Desktop
printer icon. Choose Get Info from the File menu and enter a larger amount
of memory in the Preferred Size box, then close the Get Info box. 

Apple Printer Utility can’t find an external hard disk.

You’ve attached an external hard disk to the printer. The Apple Printer Utility
can’t recognize an external hard disk if you turned the disk on after turning on
the printer.

Note:  You must initialize the hard disk before you download fonts to it.
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Change Setup (Printing menu), 
Mac OS  95

Chooser, Mac OS  15–16, 73–75, 91,
97–98

choosing the printer, Mac OS  15–16,
73–74, 91

Client Software for NetWare 
Network  23

color images, printing
Mac OS  82–83
Windows 3.1  105
Windows 95  128–129

color matching, 
Mac OS  82–83
Windows 3.1  105
Windows 95  128–129

Color Matching dialog box, Mac OS  82
ColorSync Color Matching, 

Mac OS  82–83
color for watermarks

Windows 3.1  111
Windows 95  135
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comments about the printer, inserting,
Windows 95  136

communications regulation information
ix–x

configuring the printer. See Apple Printer
Utility; Apple Printer Utility 
for Windows; the Color 
LaserWriter 12/600 PS 
User’s Manual

configuring UNIX workstations  56–68
Control Strip module, Mac OS  14
Cover Page dialog box, Mac OS  81
Ctrl-D, beginning and ending print 

jobs with
Windows 3.1  105
Windows 95  132–133

Custom Install, Mac OS  12, 14, 15, 91
Custom Installation

Windows 3.1  29, 35, 36
Windows 95  26, 33
Windows NT 3.5x  38

Custom Remove, Mac OS  15

D

data format for spooling, 
Windows 95  138

default printer, Mac OS
changing  75, 90–91
identifying  90

default printer driver options, 
Windows 3.1, changing
101–102

default printer settings, Mac OS
changing  17, 76
saving  79

De-Install LaserWriter software,
Windows 3.1  35, 36

desktop printer, Mac OS
changing  90–91
creating  75
determining status of  93
printing with  89
troubleshooting  148

desktop printer icons, Mac OS  75,
90–91, 92–93

Desktop Printer Menu, Mac OS  91
desktop printing software, Mac OS

needs more memory  148
turning off/removing  96–98

Desktop PrintMonitor, Mac OS
checking status messages in  17
installing  11, 14
turning off  96

Destination pop-up menu, Mac OS  84
Details tab dialog box, Windows 95

137–138
Device Options tab dialog box, 

Windows 95  129–130
dialog boxes

Mac OS
Background Printing  84–85
Chooser  16
Color Matching  82
Cover Page  81
Error Handling  88
Install  11–12
Layout  83
Page Setup  76, 77–79
PostScript Options  78
Print  17, 76, 79–88
Printer Specific Options  86–87
Save As File  84
Setup  76, 97–98

Windows 3.1
Features tab  108
Font Downloader  114, 115
Fonts tab  106–107
Job Control tab  108–109, 113
Page Setup  100
Paper tab  103–104
PostScript tab  104–105
Print  100
Printers  101
Setup  101–111, 114, 115–117, 118
Watermark tab  110–112



Windows 95
Advanced PostScript options

132–133
Details tab  137–138
Device Options tab  129–130
Fonts tab  135–136
General tab  136–137
Graphics tab  128–129
Paper tab  126–127
PostScript tab  130–133
Print  124
Properties  124–138
Spool Settings  138
Watermark tab  130–135

DISKS folder, Mac OS  13
document margins, unprintable area and,

Windows 95  127
DOS

capturing a print queue for  121
printing from  25

DOS PostScript driver  25
downloading fonts, Windows 3.1

automatically  112
manually  112–114
preventing  109, 113

downloading the PostScript header,
Windows 3.1  109

duplex print settings, Windows 95  127

E

Easy Install, Mac OS  11, 14
editing watermarks

Windows 3.1  111–112
Windows 95  133–135

Encapsulated PostScript file, printing to
Mac OS  79, 84
Windows 3.1  103, 117
Windows 95  131

EPS. See Encapsulated PostScript
error handling

Mac OS  87–88
Windows 3.1  109
Windows 95  131, 138

Error Handling dialog box, Mac OS  88
/etc/hosts UNIX table  54
Ethernet cables  24, 51
Ethernet networks  51, 52
EtherTalk network  16
Express Installation

Windows 3.1  29, 35, 36
Windows 95  26, 27, 33

Extensions folder, Mac OS  97
Extensions Manager control panel, 

Mac OS  96
external hard disk

adding/initializing, Windows 3.1
115–117

troubleshooting, Mac OS  148

F

Features tab dialog box, 
Windows 3.1  108

file, printing to, Mac OS  84
fixing assembly  6
flipping the page image

Mac OS  78
Windows 95  129

Floppy Disk Maker application, 
Mac OS  13

floppy disks
creating from the CD-ROM disc

Mac OS  12–13
Windows 3.1  31–32
Windows 95  31

installing printer software from
Mac OS  13–15
Windows 3.1  35–37
Windows 95  32–34

locked, Mac OS  13
preparing a server to install printer

software from, Mac OS  18–19
write-protecting

Windows 3.1  32
Windows 95  35

152 Index



folders
Mac OS

Apple LaserWriter Software  12, 15
DISKS  13
Extensions  97
INSTALL  11, 18
LaserWriter Disk 1  19
MAC OS  11, 13, 18
SOFTWARE  11, 13, 18

Windows 95, Printers  26, 125
Font Downloader, Windows 3.1

112–114, 115, 117
Font Metrics  116
fonts

downloading
Mac OS  78
Windows 3.1  112–114
Windows 95  135–136

preventing downloading of, 
Windows 3.1  109, 113

for watermarks
Windows 3.1  111
Windows 95  134

Fonts tab dialog box
Windows 3.1  106–107
Windows 95  135–136

font substitution
Mac OS  78, 84
Windows 3.1  106–107
Windows 95  135–136

foreground printing, Mac OS  85
fuser access door  5
fuser oil reservoir

troubleshooting  146–147
unpacking  1

G

General dialog box, Mac OS  79
General tab dialog box, Windows 95  136
Get Printer Info (Printing menu), 

Mac OS  95

graphics options
Mac OS  78
Windows 95  128–129

Graphics tab dialog box, Windows 95
128–129

grayscale images, printing, Mac OS
82–83

H

halftoning options, Windows 95  129
hard disk space requirements. See also

external hard disk
Mac OS  10
Windows 3.1  24
Windows 95  23

header. See PostScript header
holding a print request, Mac OS  94
HP-UX version 8.07 UNIX workstations,

configuring  60–62
HP-UX version 9.x UNIX workstations,

configuring  62–65

I

IBM AIX version 3.x UNIX
workstations, configuring
67–68

icons, Mac OS
desktop printer  75, 90–91, 92–93
Installer  14
LaserWriter 8  16, 74
LaserWriter Disk 1  19

indicator lights on printer  17
initializing an external hard disk

116–117
inserting

photoconductor  7
toner cartridges  7

installation disks, creating from the 
CD-ROM disc

Mac OS  12
Windows 3.1  31–32
Windows 95  31
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Install dialog box, Mac OS  11–12
Installer program, Mac OS  11–12, 14, 20
INSTALL folder, Mac OS  11, 18
installing printer software

Mac OS  11–15, 18–20
UNIX  52
Windows 3.1  25, 28–31, 35–37
Windows 95  25–28, 30–34
Windows NT 3.5x  37–40

interference with radio or television
reception  ix

international color standards, matching,
Windows 95  129

inverting the page image
Mac OS  78
Windows 95  129

IP address, assigning to the printer,
UNIX  52–55

J, K

Job Control tab dialog box, Windows 3.1
109, 113

job timeout setting
Windows 3.1  105
Windows 95  131

JPEG compressed images, color
matching and, Mac OS  83

L

landscape orientation  103, 126
laser information and warnings  x
LaserWriter 8 software, Mac OS  

1, 12, 14
LaserWriter Disk 1 folder, Mac OS  19
LaserWriter Disk 1 for Mac OS 18
LaserWriter Disks 1–2 for Windows 3.1

35, 36
LaserWriter Disks 1–3 for Windows 95

32, 34
Layout dialog box, Mac OS  83

Layout print setting
Mac OS  83
Windows 3.1  103
Windows 95  126

leveling the printer  2–4
location for printer, choosing  1–2
locked floppy disks. See also write-

protected floppy disks
Mac OS  13

M

Mac OS–based computers. See also
printing; Settings pop-up menu

allowing access to the printer on a
NetWare network  9, 42

AppleTalk setup  9, 10
changing the default printer  75, 90–91
changing the printer setup  75–76
choosing the printer  15–16, 73–75
installing printer software on  11–15,

18–20
naming the printer  16
page setup options  77–79
printing with a desktop printer  89–95
printing a test file  17
setting the network zone  16, 73
setting printing options  79–88
system requirements  10
turning off/removing desktop printer

software  96–98
MAC OS folder  11, 13, 18
manual feed alert message, changing,

Mac OS  95
manually fed paper, printing, Mac OS  79
margins for printable area

Windows 3.1  105
Windows 95  127

match colors. See color matching
memory

downloading fonts and, 
Windows 3.1  112
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requirements for printer software
Mac OS  10, 148
Windows 3.1  24
Windows 95  23

specifying the configuration
Mac OS  76
Windows 3.1  108
Windows 95  129, 130

mirror image
printing, Mac OS  78
printing, Windows 95  129

moving the printer  143
moving a print request to another printer,

Mac OS  95

N

naming the printer, Mac OS  16
NDS. See NetWare Directory Services
negative image, printing

Mac OS  78
Windows 95  129

NetWare
Admin vs. Supervisor superuser

account name  40
allowing Mac OS clients to access the

printer  9, 42
ATPS operating mode  41
banner pages and  40
capturing a print queue for DOS

printing  121
changes in version 4.x  40
choosing an operating mode  41
PSERVER operating mode  41, 42,

43–46
RPRINTER operating mode  41, 42,

47–50
NetWare Directory Services tree  40, 44,

45, 48, 49
NetWare Loadable Module  41
network drive, mapping to, Windows 95

137, 138

network zone. See zone
NLM. See NetWare Loadable Module
Novell NetWare. See NetWare
number of copies to print, specifying

Mac OS  79
Windows 3.1  103
Windows 95  127

number of pages to print per 
sheet, setting

Mac OS  83
Windows 3.1  103
Windows 95  126

O

oil absorption sheets, removing  5–6
oil film appears on exterior of printer,

troubleshooting  147
oil spots on printed page, 

troubleshooting  146
optional features, configuring the printer

for. See also the Color 
LaserWriter 12/600 PS 
User’s Manual

Mac OS  76
Windows 3.1  108
Windows 95  129, 130

orientation, selecting
Mac OS  77
Windows 3.1  103
Windows 95  126

out-of-paper message, Mac OS  87
output format

Mac OS  79, 84
Windows 3.1  103, 117
Windows 95  131
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P

Page Setup dialog box
Mac OS  76, 77–79
Windows 3.1  100

page setup options
Mac OS  77–79
Windows 3.1  100
Windows 95  124

Page Setup pop-up menu, Mac OS  78
pages to print per sheet, setting 

number of
Mac OS  83
Windows 3.1  103
Windows 95  126

paper jams, when printing on
transparencies  145–146

paper size, selecting
Mac OS  77
Windows 3.1  77
Windows 95  126

paper sources
Mac OS  79, 80, 81
Windows 3.1  103
Windows 95  127

Paper tab dialog box
Windows 3.1  103–104
Windows 95  126–127

paper type, Mac OS  81, 86
parallel interface cables  24, 25
parallel port, printing from, Windows  25
PCONSOLE NetWare utility  42–44, 46,

47, 49
photoconductor, inserting  7
ping assignment of printer IP address,

UNIX  53–55
port, specifying/changing, Windows 95

137–138
portrait orientation  103, 126
PostScript Color Matching, Mac OS  83
PostScript error reporting, Mac OS  87

PostScript files
printing as text, Mac OS  90
printing to

Mac OS  79, 84
Windows 3.1  103, 117–120
Windows 95  131

PostScript fonts. See also TrueType
fonts, creating/substituting
PostScript fonts for

Mac OS  78
Windows 3.1  106–107
Windows 95  135–136

PostScript header, sending
Windows 3.1  109
Windows 95  131

PostScript language level, specifying,
Windows 95  132

PostScript Level 2 features, 
Windows 3.1  104

PostScript Options dialog box, 
Mac OS  78

PostScript performance 
optimization settings

Windows 3.1  105
Windows 95  131

PostScript printer driver. See 
printer driver

PostScript tab dialog box
Windows 3.1  104–105, 119
Windows 95  130–133

Precision Bitmap Alignment PostScript
Option, Mac OS  78

printable area
Windows 3.1  105
Windows 95  127

Print dialog box
Mac OS  17, 76, 79–88
Windows 3.1  100
Windows 95  124

156 Index



printer administrator
AppleTalk setup  10
changing default printer settings

Mac OS  76
Windows 95  76

TCP/IP setup for UNIX users  52–56
Windows 95 and 3.1 printer software

installation  25
printer driver

Windows 3.1
Ctrl-D protocol options  105
how to change default options

101–102
using to print to a PostScript file

118–120
Windows 95

application incompatibility alert
message  133

Ctrl-D protocol options  132–133
how to change default options

124–125
Printer Driver Only installation

Windows 3.1  29, 35, 36
Windows 95  26, 33

printer driver Properties dialog box,
Windows 95. See Properties
dialog box

printer driver Setup dialog box, Windows
3.1. See Setup dialog box

Printers control panel, Windows 3.1  
28, 35

Printers dialog box, Windows 3.1  101
Printers folder, Windows 95  125
printer setup. See Properties dialog box,

Windows 95; Settings pop-up
menu, Mac OS; setting up the
printer; Setup dialog box

Printers folder, Windows 95  26, 32
printer software, installing

Mac OS  11–15, 18–20
UNIX  52
Windows 3.1  25, 28–31, 35–37
Windows 95  25–28, 30–34
Windows NT 3.5x  37–40

Printer Specific Options dialog box, 
Mac OS  86–87

printer zone. See zone
printing

DOS applications and  25, 121
Mac OS

background printing  84–85, 89
changing settings  79–88
color and grayscale images  82–83
a cover page  81
with a desktop printer  89–95
to a file  84
general instructions  79–81
page setup options  77–79
to a PostScript or EPS file  79
manually fed paper  79
monitoring the print queue  93–95
setting the number of pages per

sheet  83
a test file  17
transparencies  79, 86

troubleshooting  145–148
Windows 3.1

in binary or ASCII format  105,
109, 118

changing settings  101–112, to a
PostScript file  103, 117–120

color images  105
general instructions  100
page setup options  100
from the parallel port  25
setting the number of pages per

sheet  103
specifying number of copies  103
watermarks  110–111

Windows 95
in binary or ASCII format  132
changing settings  124–138
color images  105
general instructions  124
from the parallel port  25
setting the number of pages per

sheet  126
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specifying number of copies  127
spool settings  138
watermarks  134

Windows NT  99, 100
Printing menu, Mac OS  95
print output format

Mac OS  79, 84
Windows 3.1  103, 117
Windows 95  131

print quality, setting, Mac OS  81, 86, 87
Print Quality pop-up menu, Mac OS  86
print queue

capturing for DOS printing  121
creating, NetWare  45–46, 48–49
monitoring/changing, Mac OS  93–95

print requests. See also timeout settings
monitoring/changing, Mac OS  93–95

print server. See also server
creating for NetWare RPRINTER

mode  47
setting up the printer as, NetWare

PSERVER mode  43–46
print test, Mac OS  17
program-specific options, setting, 

Mac OS  81
Properties dialog box, Windows 95

Details tab  137–138
Device Options tab  129–130
Fonts tab  135–136
General tab  136–137
Graphics tab  128–129
opening  124–125
Paper tab  126–127
PostScript tab  130–133
Watermarks tab  130–135

PSERVER operating mode, NetWare  41,
42, 43–46

Q

QuickTime/QuickTake images, color
matching and, Mac OS  83

R

radio reception, interference with  ix
RARP server, assigning printer IP

address, UNIX  53, 55
ReadMe file

Windows 3.1  28–29, 35
Windows 95  26, 32–33

Read Me files, Mac OS  12, 15, 17
Remote Address Resolution Protocol. 

See RARP
remote printer, setting up the printer as,

NetWare  47–50
removing

desktop printing software, Mac OS
96–98

oil absorption sheets  5–6
shipping screw  7
shipping spacers  5

renaming a desktop printer icon, 
Mac OS  92

resolution, specifying, Windows 95  128
restarting the computer, Mac OS  12, 

14, 20
resuming printing, Mac OS  94
rotated landscape orientation  103, 126
RPRINTER operating mode, NetWare

41, 42, 47–50

S

safety instructions
laser warnings  x
moving the printer  143

Save as File dialog box, Mac OS  84
scaling the print image

Mac OS  77
Windows 3.1  103
Windows 95  129

SCO UNIX workstations, configuring
65–66
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selecting the printer. See choosing 
the printer

separator page, specifying, 
Windows 95  136

server. See also print server
installing printer software from, 

Mac OS  20
installing printer software onto

Mac OS  18–19
Windows 3.1  30–31
Windows NT 3.5x  38–40

SET BINDERY CONTEXT NetWare
command  40, 43, 47

setting the default printer, Mac OS  91
setting print time, Mac OS  94, 95
Settings pop-up menu, Mac OS

Color Matching dialog box  82–83
Cover Page dialog box  81
Error Handling dialog box  88
General dialog box  79
how to use  80–81
Layout dialog box  83
Printer Specific Options dialog box

86–87
setting up the printer

for Mac OS  9–20, 74–75
for Mac OS client computers on a

NetWare network  9, 42
for Novell NetWare  40–50
for UNIX (TCP/IP)  52–56
unpacking  1–7
for Windows 3.1  25, 28–32, 35–37
for Windows 95  25–28, 30–34
for Windows NT 3.5x  37–40

Setup dialog box. See also Properties
dialog box, Windows 95;
Settings pop-up menu, Mac OS 

Mac OS  76, 97–98
Windows 3.1

adding an external hard disk
115–117

downloading fonts  114
Features tab  108

Fonts tab  106–107
Job Control tab  109
opening  101–102
Paper tab  103–104
PostScript tab  104–105
printing to a PostScript file  118
Watermark tab  110–112

shims  2, 4
shipping screw, removing  7
shipping spacers, removing  5
Show Manual Feed Alert (Printing

menu), Mac OS  95
Silicon Graphics IRIX UNIX

workstations, configuring  68
smoothing edges of bitmapped text or

graphics, Mac OS  78
SOFTWARE folder, Mac OS  11, 13, 18
sorting documents in the print queue,

Mac OS  95
Spool Settings dialog box, 

Windows 95  138
spots on printed pages, 

troubleshooting  147
status messages in the Desktop

PrintMonitor, Mac OS  17
Stop/Start Print Queue (Printing menu),

Mac OS  95
substituting fonts

Mac OS  78
Windows 3.1  106–107
Windows 95  135–136

Sun OS ver. 4.1 UNIX workstations,
configuring  57–59

Sun Solaris UNIX workstations,
configuring  56–57

Supervisor account, NetWare  40
switching to another paper cassette, 

Mac OS  87–88
switching between printers, Mac OS

90–91
SYSTEM.INI file, Windows, changing

for network use of Apple Printer
Utility  30–31
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system requirements for printer software
Mac OS  10
Windows 3.1  24
Windows 95  23

system software, Mac OS, purchasing
12, 14

T

TCP/IP protocol, setup for UNIX users
52–56

television reception, interference with  ix
throwing away a desktop printer icon,

Mac OS  92
timeout settings

Windows 3.1  105
Windows 95  131, 138

toner cartridges, inserting  7
Transmission Control Protocol/Internet

Protocol. See TCP/IP
transparencies, printing

Mac OS  79, 86
troubleshooting  145–146

tray selection, Mac OS  80
tray switching

Windows 3.1  108
Windows 95  129, 130

troubleshooting
desktop printer icon has an X 

through it  148
fuser oil appears on exterior 

of printer  147
fuser pump failure  147
horizontal bands appear on the 

page  146
Mac OS

Apple Printer Utility can’t find an
external hard disk  148

desktop printing software needs
more memory  148

document doesn’t print  17
oil spots on page  146

printer jams when printing on
transparencies  145–146

spots on printed pages  147
TrueType fonts, creating/substituting

PostScript fonts for
Mac OS  78
Windows 3.1  106–107
Windows 95  135–136

turning off Desktop PrintMonitor, 
Mac OS  96

U

Ultrix UNIX workstations, configuring
57–59

UNIX systems
assigning an IP address to the printer

53–55
configuring the printer  69
configuring user workstations

HP-UX version 8.07 and 9.x
60–65

IBM AIX version 3.x  67–68
SCO UNIX  65–66
Silicon Graphics IRIX  68
Sun OS version 4.1, Ultrix, A/UX,

other BSD systems  57–59
Sun Solaris  56–57

TCP/IP setup  52–56
Unlimited Downloadable Fonts

PostScript option, Mac OS  78
unprintable area, Windows 95  127

V

virus-detection programs, Mac OS,
installing printer software and
11, 12, 13, 14, 20
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W, X, Y

wait timeout setting
Windows 3.1  105
Windows 95  131

watermarks
Windows 3.1  103, 110–112
Windows 95  133–135

Watermark tab dialog box
Windows 3.1  110–112
Windows 95  130–135

weight of printer  1
Windows 3.1. See also printing; Setup

dialog box
adding an external hard disk  115–117
downloading fonts  112–114
installing printer software for  25,

28–31, 35–37
page setup options, selecting  100
printing options, setting  101–112
printing to a PostScript file  117–120
system requirements  24

Windows 95. See also printing;
Properties dialog box

installing printer software for  25–28,
30–34

page setup options, selecting  124
printing to a PostScript file  130–133
printing properties, setting  124–138
system requirements  23

Windows Control Panel
Windows 3.1  28, 35
Windows 95  26, 32

Windows NT 3.5x
installing printer software for  37–40
printing from  99, 100

write-protected floppy disks. See also
locked floppy disks

Windows  32, 35

Z

zone, setting, Mac OS  16, 73, 97
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